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Safety and environmental notices

Safety notices may be printed throughout this guide:

* DANGER notices call attention to a situation that is potentially lethal or extremely hazardous to
people.

* CAUTION notices call attention to a situation that is potentially hazardous to people because of some
existing condition.

* Attention notices call attention to the possibility of damage to a program, device, system, or data.
World Trade safety information

Several countries require the safety information contained in product publications to be presented in their
national languages. If this requirement applies to your country, a safety information booklet is included
in the publications package shipped with the product. The booklet contains the safety information in
your national language with references to the U.S. English source. Before using a U.S. English publication
to install, operate, or service this product, you must first become familiar with the related safety
information in the booklet. You should also refer to the booklet any time you do not clearly understand
any safety information in the U.S. English publications.

German safety information

Das Produkt ist nicht fiir den Einsatz an Bildschirmarbeitspldtzen im Sinne § 2 der
Bildschirmarbeitsverordnung geeignet.

Laser safety information
IBM® servers can use I/O cards or features that are fiber-optic based and that utilize lasers or LEDs.
Laser compliance

All lasers are certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter ] for class
1 laser products. Outside the U.S., they are certified to be in compliance with IEC 60825 as a class 1 laser
product. Consult the label on each part for laser certification numbers and approval information.

CAUTION:
This product might contain one or more of the following devices: CD-ROM drive, DVD-ROM drive,
DVD-RAM drive, or laser module, which are Class 1 laser products. Note the following information:

* Do not remove the covers. Removing the covers of the laser product could result in exposure to
hazardous laser radiation. There are no serviceable parts inside the device.

* Use of the controls or adjustments or performance of procedures other than those specified herein
might result in hazardous radiation exposure.

(C026)
CAUTION:
Data processing environments can contain equipment transmitting on system links with laser modules

that operate at greater than Class 1 power levels. For this reason, never look into the end of an optical
fiber cable or open receptacle. (C027)

CAUTION:
This product contains a Class 1M laser. Do not view directly with optical instruments. (C028)

© Copyright IBM Corp. 2007, 2008 \%



CAUTION:

Some laser products contain an embedded Class 3A or Class 3B laser diode. Note the following
information: laser radiation when open. Do not stare into the beam, do not view directly with optical
instruments, and avoid direct exposure to the beam. (C030)

Power and cabling information for NEBS (Network Equipment-Building System)
GR-1089-CORE

The following comments apply to the IBM servers that have been designated as conforming to NEBS
(Network Equipment-Building System) GR-1089-CORE:

The equipment is suitable for installation in the following;:
* Network telecommunications facilities
* Locations where the NEC (National Electrical Code) applies

The intrabuilding ports of this equipment are suitable for connection to intrabuilding or unexposed
wiring or cabling only. The intrabuilding ports of this equipment must not be metallically connected to the
interfaces that connect to the OSP (outside plant) or its wiring. These interfaces are designed for use as
intrabuilding interfaces only (Type 2 or Type 4 ports as described in GR-1089-CORE) and require isolation
from the exposed OSP cabling. The addition of primary protectors is not sufficient protection to connect
these interfaces metallically to OSP wiring.

Note: All Ethernet cables must be shielded and grounded at both ends.
The ac-powered system does not require the use of an external surge protection device (SPD).

The dc-powered system employs an isolated DC return (DC-I) design. The DC battery return terminal
shall not be connected to the chassis or frame ground.

Product recycling and disposal

This unit must be recycled or discarded according to applicable local and national regulations. IBM
encourages owners of information technology (IT) equipment to responsibly recycle their equipment
when it is no longer needed. IBM offers a variety of product return programs and services in several
countries to assist equipment owners in recycling their IT products. Information on IBM product
recycling offerings can be found on IBM’s Internet sites at |http://www.ibm.com/ibm /recycle/us/ |
[index.shtml|and |http:/ /www.ibm.com/ibm/environment/products /index.shtml|

Esta unidad debe reciclarse o desecharse de acuerdo con lo establecido en la normativa nacional o local
aplicable. IBM recomienda a los propietarios de equipos de tecnologia de la informacién (TI) que reciclen
responsablemente sus equipos cuando éstos ya no les sean titiles. IBM dispone de una serie de programas
y servicios de devolucién de productos en varios paises, a fin de ayudar a los propietarios de equipos a
reciclar sus productos de TI. Se puede encontrar informacién sobre las ofertas de reciclado de productos
de IBM en los siguientes sitios web de IBM |http:/ /www.ibm.com/ibm/ recycle/us/ index.shtm]] y

Ihttp: / /www.ibm.com/ibm /environment/products/ index.shtmll

Note: This mark applies only to countries within the European Union (EU) and Norway:.
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Appliances are labeled in accordance with European Directive 2002/96/EC concerning waste electrical
and electronic equipment (WEEE). The Directive determines the framework for the return and recycling
of used appliances as applicable throughout the European Union. This label is applied to various
products to indicate that the product is not to be thrown away, but rather reclaimed upon end of life per
this Directive.

Remarque : Cette marque s’applique uniquement aux pays de 1’Union
Européenne et a la Norvege.

L’etiquette du systéme respecte la Directive européenne 2002/96/EC en matiére
de Déchets des Equipements Electriques et Electroniques (DEEE), qui détermine
les dispositions de retour et de recyclage applicables aux systémes utilisés a
travers 1I’Union européenne. Conformément a la directive, ladite étiquette précise
que le produit sur lequel elle est apposée ne doit pas étre jeté mais étre récupéré
en fin de vie.

AE O COvT—PRFEIBEEEU/S LY —ZELNTOAAEERET.

ZOEBITIE, EUGEIICH S B S AR T 2002/96/EC(WEEE) & F <Atk BT
VEY, TOESE, EUERCEAYT s ERFABEOERE VY S S ADHFEEL TN

£9, SOFAULR, ERAEAC oL ETIC o THELRNEETILENDDI L ¥
AbEafwmicfis DEACHEER TV ET,

In accordance with the European WEEE Directive, electrical and electronic equipment (EEE) is to be
collected separately and to be reused, recycled, or recovered at end of life. Users of EEE with the WEEE
marking per Annex IV of the WEEE Directive, as shown above, must not dispose of end of life EEE as
unsorted municipal waste, but use the collection framework available to customers for the return,
recycling, and recovery of WEEE. Customer participation is important to minimize any potential effects of
EEE on the environment and human health due to the potential presence of hazardous substances in EEE.
For proper collection and treatment, contact your local IBM representative.

Battery return program

This product may contain one or more sealed lead acid, nickel cadmium, nickel metal hydride, lithium,
or lithium ion batteries. Consult your user manual or service manual for specific battery information. The
battery must be recycled or disposed of properly. Recycling facilities may not be available in your area.
For information on disposal of batteries outside the United States, go to |http://www.ibm.com/ibm /|
fenvironment/products/index.shtml| or contact your local waste disposal facility.

In the United States, IBM has established a return process for reuse, recycling, or proper disposal of used
IBM sealed lead acid, nickel cadmium, nickel metal hydride, and other battery packs from IBM
Equipment. For information on proper disposal of these batteries, contact IBM at 1-800-426-4333. Please
have the IBM part number listed on the battery available prior to your call.

For Taiwan:

Please recycle batteries & & & 3 B

For the European Union:
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Note: This mark applies only to countries within the European Union (EU).

Batteries or packaging for batteries are labeled in accordance with European Directive 2006/66/EC
concerning batteries and accumulators and waste batteries and accumulators. The Directive determines
the framework for the return and recycling of used batteries and accumulators as applicable throughout
the European Union. This label is applied to various batteries to indicate that the battery is not to be
thrown away, but rather reclaimed upon end of life per this Directive.

Les batteries ou emballages pour batteries sont étiquetés conformément aux directives
européennes 2006/66/EC, norme relative aux batteries et accumulateurs en usage et aux
batteries et accumulateurs usés. Les directives déterminent la marche a suivre en
vigueur dans 1'Union Européenne pour le retour et le recyclage des batteries et
accumulateurs usés. Cette étiquette est appliquée sur diverses batteries pour indiquer
que la batterie ne doit pas étre mise au rebut mais plutdt récupérée en fin de cycle de
vie selon cette norme.

Ay T U—BLHNEA e T —FBosiwsr—OCik, B BEEICHT SEESEFIRE
5% 2006/66/EC MSAILMIEENTET., COESE, AuTU—EETH, £+
UREA T —EEFERMTLLOTY. ZOHSL. EFAFAH 0T —LEE
MOEEE S 2 ILOFEEEHTHELOT, EU BEIZhHh=-2THEEZAET,

COIALE, FREFAICE 2 ESICHESICH - TERGNE ST I BENEDL &
FHGELABIcEsA vy T —IClEShTIVET,

In accordance with the European Directive 2006/66/EC, batteries and accumulators are labeled to
indicate that they are to be collected separately and recycled at end of life. The label on the battery may
also include a chemical symbol for the metal concerned in the battery (Pb for lead, Hg for mercury and
Cd for cadmium). Users of batteries and accumulators must not dispose of batteries and accumulators as
unsorted municipal waste, but use the collection framework available to customers for the return,
recycling, and treatment of batteries and accumulators. Customer participation is important to minimize
any potential effects of batteries and accumulators on the environment and human health due to the
potential presence of hazardous substances. For proper collection and treatment, contact your local IBM
representative.

This notice is provided in accordance with Royal Decree 106/2008 of Spain: The retail price of batteries,
accumulators and power cells includes the cost of the environmental management of their waste.

For California: Perchlorate Material - special handling may apply. See [www.dtsc.ca.gov/hazardouswaste/|

perchlorate

The foregoing notice is provided in accordance with California Code of Regulations Title 22, Division 4.5
Chapter 33. Best Management Practices for Perchlorate Materials. This product, part, or both may include
a lithium manganese dioxide battery which contains a perchlorate substance.
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Water cooling systems

If this product contains a water cooling system, the following paragraph applies: The system contains
0.1% Benzotriazole Aqueous Solution supplied by Sigma Aldrich Corporation. A Safety Data Sheet is
supplied with the product, which should be referenced for first aid, handling, personal protection,
disposal, and other relevant information. This chemical solution is classified as nonhazardous according
to European Union Directive 67/548/EEC; however, it is recommended that eye protection be used when
handling the chemical. Observe all federal, provincial, state, local, and other applicable environmental
regulations for disposal. Contact a licensed professional waste disposal service to dispose of this material.
If an additional copy of the Safety Data Sheet is required, please send the request to
prodinfo@us.ibm.com.

Safety and environmental notices ix
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Chapter 1. Hardware Management Console reference
information

Learn about maintaining and servicing the hardware management console (HMC).

The HMC connects to one or more managed systems to perform various functions. The HMC's primary
functions include the following:

* Providing a console for system administrators and service providers to manage server hardware.
* Creating and maintaining a multiple partitioned environment on a managed system.

* Detecting, reporting, and storing changes in hardware conditions.

* Acting as a service focal point for service providers to determine an appropriate service strategy.
* Displaying operating system session terminals for each partition.

The HMC is delivered with its machine code preinstalled on the disk drive. After the system is installed
and connected to a managed system, you can perform system management tasks.

The HMC machine code does not have provisions for loading or running additional applications that are
not related to hardware management or service. All the tasks you need to maintain the managed system,
the underlying operating system, and the HMC machine code are available by using the HMC
management interface.

Identifying your HMC

This information supports HMC machine types 7042-CR4, 7042-C06, and 7042-C07.

The following illustrations identify each of the machine type 7042 models and show the cable connections
located on the back of each HMC model.

Rack USB 3 connector Operator Rack
release USB 4 connector information release

latch Video connector\ panel Iatch

SN EE SIS EEE N
A T ) [ Ty D0 e ﬁ.m 5 gﬁ
JCEEET (N | — v

. g . Hard disk drive <
2.5-inch hard disk drives \ status LED §
Z

Hard disk drive  CD-RW/DVD CD-RW/DVD T
activity LED drive activity LED eject button

Figure 1. Model 7042-CR4 (Front view)
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Figure 2. Model 7042-C06 and Model 7042-C07(Front view)

Managed system operation

The HMC graphical user interface provides the functions needed to create and maintain a partitioned
environment on a managed system. Using the interface allows for direct manipulation of HMC-defined
objects and increased information regarding detected changes in hardware conditions.

The managed system can be run as a partitioned system, sometimes referred to as logically partitioned.
This means that the managed system can run multiple operating systems simultaneously. The system can
also run as a large single partition, which is known as the manufacturing default configuration when the
system is delivered. If the system has been partitioned, then the single partition that uses all the system
resources is referred to as a full system partition.

Partitioning provides users with the ability to divide a single managed system into several systems. Each
of these systems, running in a partition, can run applications in multiple, independent environments
simultaneously. Logical partitioning makes it possible for a user to run a single application using different
sets of data on separate partitions, as if that application were running independently on separate physical
systems. By creating partitions, for example, a company can test its programs in one partition while
developing the same program in another, at the same time, all using the same system. This "same
system” partitioning method is more cost-effective, potentially eliminating the need for a separate test
system.

The full system partition is no different from the traditional way of using a system. The single server uses
all of its resources as one system.
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HMC system diagnostics

Your HMC system also provides a set of diagnostic procedures to be used when troubleshooting HMC
problems. For details on accessing the HMC diagnostics, see [Chapter 2, “Diagnostics,” on page 5

Power on the HMC

For HMC power-on procedures, see [“Power on the HMC” on page 32.

Power off the HMC

For HMC power-off procedures, see [“Power off the HMC” on page 33

Power-on self-test

To perform Power-on self-test procedures, see [“Power-on self-test” on page 33

Specifications and system unit locations

Your HMC system is based on a model of personal computer. For information about system specifications
and system unit locations, use the appropriate personal computer hardware maintenance manuals. See
[“Equivalent maintenance information for the HMC personal computer hardware” on page 5|

Cable the HMC

For HMC power off procedures, see [Chapter 5, “Cabling the HMC,” on page 23]

External ac power cable for the HMC

To avoid electrical shock, a power cable with a grounded attachment plug is provided. Use only properly
grounded outlets.

Power cables used in the United States and Canada are listed by Underwriter’s Laboratories (UL) and
certified by the Canadian Standards Association (CSA). These power cords consist of the following:

* Electrical cables, type ST
* Attachment plugs complying with National Electrical Manufacturers Association (NEMA) L6-30P

* Appliance couplers complying with International Electrotechnical Commission (IEC) Standard 320,
Sheet C13 and C14

Power cables used in other countries consist of the following:

¢ Electrical cables, type HD21 or HD22

* Attachment plugs approved by the appropriate testing organization for the specific countries where
they are used

* Appliance couplers complying with the International Electrotechnical Commission (IEC) Standard 320,
Sheet C13 and C14

For a listing of power cables used by the HMC, see [“Power cords” on page 20|

For a more complete listing of HMC external cables and power cords, refer to latest version of the Site
and Hardware Planning Guide, order number SA76-0091-0x.

Chapter 1. Hardware Management Console reference information 3
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Chapter 2. Diagnostics

Learn about the HMC diagnostic path and how to find additional information about the base hardware.

If a problem is determined to be in your HMC, read, understand then perform the procedures found in
this chapter.

The HMC problem analysis procedure will guide you to the appropriate repair action. Occasionally, you
will be directed to the maintenance documentation for the HMC base personal computer. When this
occurs, the maintenance documentation for the personal computer is used to complete the repair action.

Service request numbers

All service request numbers (SRCs), also know as error codes, that pertain to the function of the HMC
can be found in System Reference Codes Volume 3 Cxxx - Hxxx , order number SA76-0110-02.

HMC "connection error codes” are 6 digits in length and begin with a "0”, all other HMC error codes are
8 digits in length and begin with the alphabetic characters "HSC.” The HMC error codes are organized in
the following categories:

* Oxxxxx connection error codes

* HSCExxxx console events error codes

* HSCFxxxx Licensed Internal Code error codes
* HSCIxxxx Inventory Scout Services error codes
* HSCLxxxx error codes

¢ HSCPxxxx platform management error codes

* HSCSxxxx Service Focal Point error codes

Equivalent maintenance information for the HMC personal computer hardware

Use the information provided to help cross-reference your HMC equivalent machine type and model
number for the base personal computer. You can use the entries in this table to link directly to the base
PC maintenance documentation.

Table 1. Equivalent maintenance information for the HMC’s personal computer hardware

HMC machine type and model
number (available on the serial
number plate of your HMC)

Equivalent PC server machine type
and model number

Order numbers for supporting
Hardware Maintenance Manuals
(HMM)

7310-CR4 and 7042-CR4 7978 Model 42U or 7978 Model PBT® |{41w1484
7310-C06 and 7042-C06 4362 Model 52U or 4362 Model PAT  |43w695
7042-C07 4367 Model 32U 43w7064t

For the latest information regarding maintenance of your HMC PC, system board specifications, and
parts, refer to the PC hardware maintenance manuals. To obtain the latest versions of these publications
through the IBM web site, follow this procedure:

N

© Copyright IBM Corp. 2007, 2008
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Select Support & downloads.

Go to OSelect product or service type for supporth and expand the "Choose support type” box.
Select System x from the menu listing, and then select the Go icon.
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o

On the right side of the menu, locate the "Quick path” box and type in the PC model that corresponds
to your HMC, then select Go.

Select the Troubleshooting tab, located on the support menu.

In the Available topics box select Service/Support guide. Then click the Go icon.

Click on the link that appears below "Service/Support guide”.

Click on the file link number listed below "File link”. The file for the hardware maintenance manual
will open.

©CoN®

Diagnostics, test, and recovery

The following tools are available to help identify and resolve hardware-related problems:
* Power-on self-test (POST)

— POST beep codes

— Error code format
* Sector disk drive scanning procedure

To do a scan of your HMC disk drive, do the following:
1. Power off the HMC.
2. Power on the HMC.
3. As the HMC is rebooting, watch the HMC display. After the second BroadCom Ethernet driver
screen is displayed, simultaneously press the "CTRL" key and the letter "A" key.
4. From the list of options, select Disk Utilities.
5. Select Verify Disk Media.... The HMC will perform a scan of your disk drive.
* PC-Doctor

Note: For additional information about items in the previous list, see the appropriate personal computer
hardware maintenance manual. To access the personal computer hardware maintenance documentation,
refer to the [“Equivalent maintenance information for the HMC personal computer hardware” on page 5

PC-Doctor

PC-Doctor is a set of diagnostic and system information tools included with the HMC. In rack-mounted
HMC models, PC-Doctor is preinstalled on the system. PC-Doctor is included on the HMC Recovery CDs
for Version 3.0 Release 3 (or later) for HMC models that are not rack-mounted.

Note:

* ISO image support is available on CD-ROM for the PC models 8485, 4362 and the HMC models
7xxx-C05 and 7xxx-C06 or at the following web site: http:/ /www.ibm.com.

* ISO image support is available on diskettes or CD-ROM for the PC models 8305, 8187, 8141 and the
HMC models 7xxx-C03 and 7xxx-C04 HMCs or at the following web site: http://www.lenovo.com

Running PC-Doctor on an HMC that is not rack-mounted

Before accessing the PC-Doctor application on the HMC, create a bootable diskette (referred to as the
PC-Doctor diskette in this topic.

To create the diskette:

1. Insert volume 2 of HMC Recovery CD into the CD drive.
2. Select Start > My Computer.

3. Open the CD and go to the pc_diag directory.

4

. Open the readme file and follow the instructions for creating the PC-Doctor diskette using the
pc_diag.exe tool.

To run PC-Doctor:
1. Power off the HMC.
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2. Insert the PC-Doctor diskette that you created.
3. Power on the HMC.

If the HMC does not read the PC-Doctor diskette upon startup, the problem might be due to the startup
sequence. To make the PC-Doctor diskette the primary startup media, do the following:

1. Power off the HMC.

Power on the HMC and when the Setup Utility prompts during startup, press F1.
Select the Startup tab.

Highlight Startup Sequence and press Enter.

ok 0N

Under Primary Startup Sequence, make sure the first startup device is set to Removable. Then follow
the remainder of the instructions on the screen to complete the procedure.

Running PC-Doctor on a rack-mounted HMC

Note:

* A rack-mounted HMC has PC-Doctor preinstalled in read only memory (R)M). The diagnostics are run
from ROM, there is no boot media required.

* If you are directed by a your service provider, you can obtain and install updated versions of
PC-Doctor.

— The updates for PC model 7978 and HMC 7xxx-CR4 can be obtained from diskette, CD-ROM, or
going to web site http://www.ibm.com.

— The updates for PC models 8837, 8676 and HMC models 7xxx-CR3, and 7xxx-CR2 can be obtained
from diskettes, or going to web site http://www.ibm.com.

To run PC-Doctor on a rack-mounted HMC:
1. Turn off the power to the HMC.

2. Turn on the power to the HMC and press F2 when the message F2 for Diagnostics is displayed,
press F2.

3. If prompted, type the appropriate password, then press Enter.
4. Select either Extended or Basic from the top of the screen.

5. From the diagnostic screen, select the test you want to run from the list and then follow all
instructions.

Note: For additional information about HMC diagnostics, go to the diagnostics section in the appropriate
personal computer hardware maintenance manual. To access the personal computer hardware
maintenance documentation, refer to [“Equivalent maintenance information for the HMC personal|
fcomputer hardware” on page 5.

Connector and hard disk drive restrictions for the HMC

Models 7310-C05 and 7042-C05 have the following two hard disk drive restrictions:
¢ Use of the parallel port

Note: The HMC is a closed system and as such, the hardware is used in a limited manner. No device
drivers or code support any peripheral devices that use a parallel port.

e Use of more than one hard disk drive

To view the location of each HMC connector, refer to [Chapter 5, “Cabling the HMC,” on page 23|
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Chapter 3. Removal and replacement procedures

Select and then perform the part removal and replacement procedures for the personal computer on
which your HMC is based.

Depending on the system configuration, when you are directed to exchange parts, run tests, or change
configuration data, the interface to the managed systems will be unavailable. If possible, before starting
any of these tasks, ensure that all system management tasks are completed and all critical data is backed

up.

Attention:

* Removing power from an HMC might cause loss of data on the disk drives. If power must be
removed, select Power Off from the HMC user interface. This action shuts down the operating system
and turns off the power to the HMC. See ['HMC and system power on and power off procedures” on|
before proceeding with any of the removal procedures.

* The system board, adapters, memory modules, and processor modules can be damaged by electrostatic
discharge. If you are directed to exchange FRUs in a HMC, refer to the “Handling Electro-Static
Discharge (ESD) Sensitive Devices ” in the appropriate PC maintenance information manuals.

When you are referred to the hardware maintenance manual for the personal computer, use the hardware
maintenance manual for the appropriate personal computer machine type. To find documentation about
the base HMC personal computer and its components, see [“Equivalent maintenance information for the|
[HMC’s personal computer hardware”|

Equivalent maintenance information for the HMC’s personal computer hardware

The following table provides information to help cross-reference your HMC equivalent machine type and
model number for the base personal computer. You can use the entries in this table to link directly to the
base PC maintenance documentation.

Table 2. Equivalent maintenance information for the HMC’s personal computer hardware

HMC machine type and model Equivalent PC server machine type |Order numbers for supporting
number (available on the serial and model number Hardware Maintenance Manuals
number plate of your HMC) (HMM)

7310-CR4 and 7042-CR4 7978 Model 42U or 7978 Model PBT  |41w1484

7310-C06 and 7042-C06 4362 Model 52U or 4362 Model PAT  |43w695

7042-C07 4367 Model 32U 43w7064t

For the latest information regarding maintenance of your HMC PC, system board specifications, and
parts, refer to the PC hardware maintenance manuals. To obtain the latest versions of these publications
through the IBM web site, follow this procedure:

Go to the Web site at http:/ /www.ibm.com.

Select Support & downloads.

Go to OSelect product or service type for supporth and expand the "Choose support type” box.

Select System x from the menu listing, and then select the Go icon.

On the right side of the menu, locate the "Quick path” box and type in the PC model that corresponds
to your HMC, then select Go.

Select the Troubleshooting tab, located on the support menu.

In the Available topics box select Service/Support guide. Then click the Go icon.

8. Click on the link that appears below "Service/Support guide”.

S A

N o
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9. Click on the file link number listed below "File link”. The file for the hardware maintenance manual
will open.

Recovering the HMC

If the HMC has had a problem and you need to recover the HMC, see [‘Reinstalling the HMC machine]
fcode” on page 34/

Attention: This procedure will restore the HMC image onto the disk drive in the HMC personal
computer. Before performing this procedure, contact HMC support and also ensure that there are backups
for all critical console data.

Backing up partition profiles

Ensure that critical data that is stored on the HMC is also regularly maintained on backup media.

To back up partition profiles, see [‘Back up partition profiles” on page 35

HMC machine code updates

For information about updates or upgrades for the HMC machine code, refer to|‘Upgrading the machine]
fcode on an HMC from Version 6 to Version 7” on page 37

Recovering an HMC after replacing a disk drive

If you have to replace a disk drive, you must recover the HMC image and restore your stored profile
data. Go to [“Reinstalling the HMC machine code” on page 34| for more information.

Performing the firmware (BIOS/VPD) update procedure (after replacing the system
board)

When your replace the system board, perform the firmware update procedure for your HMC personal
computer.

Attention: Refer to the information label located inside the system unit cover for any model-specific
information.

To perform the firmware (BIOS/VPD) update procedure, perform the following steps:

1. To find documentation about the base HMC personal computer and its components, see |”Equivalenﬂ
[maintenance information for the HMC'’s personal computer hardware” on page 9.|

2. Review the section in your HMC personal computer information for "Updating the firmware.”
3. Perform" the procedures to update the new system board with the latest BIOS firmware.

4. Perform the procedures to update the vital product data (VPD) information with the machine type,
model, and serial number for the HMC.

5. Return the HMC to normal operations.
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Chapter 4. Hardware Management Console parts

Contains illustrations, part descriptions and part numbers that are used when ordering replacement parts
for your Hardware Management Console (HMC).

Personal computer parts
Contains part number information for parts used in assembling your HMC.

Note: FRU parts and part numbers are subject to update due to our parts system substitution-update
policy. With our parts system substitution-update policy we make every effort to supply you with the
latest components available for your model HMC.

The following table contains a cross-reference equivalent of the HMC machine type and model number to
the personal computer machine type and model number. For personal computer parts information not
listed in the following tables, refer to the hardware maintenance manual for your personal computer.

Table 3. Equivalent maintenance information for the HMC’s personal computer hardware

HMC machine type and model Equivalent PC server machine type |Order numbers for supporting
number (available on the serial and model number Hardware Maintenance Manuals
number plate of your HMC) (HMM)

7310-CR4 and 7042-CR4 7978 Model 42U or 7978 Model PBT |41w1484

7310-C06 and 7042-C06 4362 Model 52U or 4362 Model PAT |43w695

7042-C07 4367 Model 32U A3w70644]

For the latest information regarding maintenance of your HMC PC, system board specifications, and
parts, refer to the PC hardware maintenance manuals. To obtain the latest versions of these publications
through the IBM web site, follow this procedure:

1. Go to the Web site at http://www.ibm.com.

2. Select Support & downloads.

3. Go to (Select product or service type for supporth and expand the "Choose support type” box.

4. Select System x from the menu listing, and then select the Go icon.

5. On the right side of the menu, locate the "Quick path” box and type in the PC model that corresponds
to your HMC, then select Go.

6. Select the Troubleshooting tab, located on the support menu.

7. In the Available topics box select Service/Support guide. Then click the Go icon.

8. Click on the link that appears below "Service/Support guide”.

9. Click on the file link number listed below "File link". The file for the hardware maintenance manual

will open.
7310-CR4 and 7042-CR4 parts

Models 7310-CR4 and 7042-CR4 use a personal computer machine type of 7978 Model 42U for its base
configuration. To access the personal computer hardware maintenance manuals, see [Personal computer|

Note: Each PC hardware maintenance manual may reference more than one machine type in its title. If
necessary, to cross-reference to the original PC hardware maintenance manual, make sure that you find
the hardware maintenance manual for the PC machine type and model for the HMC that you are
servicing.
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The following illustration and table identifies the major components that make up the Models 7310-CR4
and 7042-CR4.
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Figure 3. Models 7310-CR4 and 7042-CR4 parts illustration

Notes:

1. Field replaceable units (FRUs) must be serviced only by an authorized service provider.

2. Customer replaceable units (CRUs) can be replaced by the customer. The CRUs are defined as either
Tier 1 or Tier 2 as follows:

Tier 1 CRU
Procedure that a customer can perform without input from a service provider. The procedure
used to service this type of component is usually required to be done by the customer.

Tier 2 CRU
Procedure that a customer can perform, but may require support from a service provider. The
procedure used to service this component is usually not required to be done by the customer.

3. If the part you are replacing is not identified as being either Tier 1 or Tier 2, call your service provider
to service the FRU.

Table 4. 7310-CR4 and 7042-CR4 Parts listing

Index |Description Tier 1 Tier 2 | Part number
CRUs CRUs

1 Top cover assembly * 43W0609
2 Heat sink assembly 39Y9423
3 Air baffles * 39Y9420
4 Memory, 512 MB ECC DRR * 39M5781
5 Not applicable to this model

6 PCI-X riser card * 39Y6975
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Table 4. 7310-CR4 and 7042-CR4 Parts listing (continued)

Index |Description Tier 1 Tier 2 |Part number
CRUs CRUs

7 Not applicable to this model

8 Planar, SATA 42D3639

9 Power supply, 670 W * 39Y7189

10 Power supply filler panel * XXXXXXX

11 Chassis assembly 39Y9522

12 Fan assembly unit (dual fans) * 26K8083

13 DVD-RAM Dirive * 42C0955

14 Operator information panel card assembly 39K6973

15 Not applicable to this model

16 Not applicable to this model

17 Not applicable to this model

18 Not applicable to this model

19 Power backplane * 39Y6972

Table 5. 7310-CR4 Parts listing (continued)
Index |Description Units Part number

20 Not applicable to this model

21 Simple-swap filler panel, 3.5 inch * 23K4990

22 Disk drive, 80 GB SATA * 39M4503

23 Not applicable to this model

24 Simple-swap SATA disk drive cage * 32R2823

25 Not applicable for this model

26 Power cable, SATA, with backplate * 26K8060
Microprocessor, 2.0 GHz with heat sink 42C4229
Media bezel assembly * 39Y9419
Rack latch assembly, EIA * 26K8080
Service label, 3.5 inch, SATA * 32R2820
Service label, right fan door * 39Y9418
USB connector cable, front panel (field replaceable unit) * 26K8058
CD-RW/DVD drive interposer card * 42C3983
Slides and hardware * 52P8517
Battery, system board, 3.0 V * 33F8354
Mouse, (Black) * 03N6669
Modem cable (see [“HMC modem cable part numbers” on|
page 1)

7310-C06 and 7042-C06 parts

Machine type 7310-C06 and 7042-C06 use a personal computer machine type of 4362-52U for its base
configuration. To access the personal computer hardware maintenance manuals, see [“Personal computer

[parts” on page 11

Chapter 4. Hardware Management Console parts
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Note: Each PC hardware maintenance manual may reference more than one machine type in its title. If
necessary, to cross-reference to the original PC hardware maintenance manual, make sure that you find
the hardware maintenance manual for the PC machine type and model for the HMC that you are
servicing.

The following illustration and table identifies the major components that make up the Models 7310-C06
and 7042-C06.

IPHAU431-0
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Figure 4. Models 7310-C06 and 7042-CO06 patrts illustration

Notes:

1. Field replaceable units (FRUs) must be serviced only by an authorized service provider.

2. Customer replaceable units (CRUs) can be replaced by the customer. A definition of Tier 1 and Tier 2
CRUEs for this model HMC is:

Tier 1 CRU
Uses a procedure that a customer can perform without input from a service provider. The
procedure used to service this type of component is usually required to be done by the
customer.

Tier 2 CRU
Uses a procedure that a customer can perform, but may require support from a service
provider. The procedure used to service this component is usually not required to be done by
the customer.

3. If the part you are replacing is not identified as being either Tier 1 or Tier 2, call your service provider
to service the FRU.

Table 6. 7310-C06 and 7042-C06 parts listing

Index |Description Tier 1 Tier 2 | Part number
CRU CRU
1 Chassis assembly, non-redundant power supply 42C8916
2 Front-panel assembly * 25R8865
3 Front USB connector assembly (cable) * 26K7340
4 DVD-RAM drive * 39M3565
5 Diskette drive * 33P3343
6 Diskette drive bezel * 25R8857
7 Bezel, upper * 42C8912
8 Bezel, lower * 42C8913
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Table 6. 7310-C06 and 7042-CO06 parts listing (continued)

Index |Description Tier 1 Tier 2 |Part number
CRU CRU
9 Hard disk drive, SATA, 80 GB simple swap * 39M3701
Disk drive tray * 25R8864
Half -Height disk drive, slim bare Rambo-5 * 42C0957
10 Retention bracket, PCI * 13N2993
11 Hard disk drive cage, 3.5-inch * 42C8910
12 Disk drive backplane (for 3.5 inch simple-swap SATA disk drives) * 25R8842
13 3.5 inch disk drive air-duct assembly * 39Y9860
14 System board assembly 43W4982
15 SAS/SATA controller * 42C1279
16 Microprocessor, 2.13 GHz 41Y3849
17 Fan-sync 43W0401
18 Side cover with lock * 25R8859
19 | Power supply, 400° watt 39Y7297
20 Memory, 512MB * 41Y2725
21 System fan, rear * 25R8829
PSU adapter bracket (not shown) * 42C7509
7310-C06 parts listed in the following table are not illustrated.
Table 7. 7310-C06 and 7042-C06 parts listing (continued)
Description Tier 1 Tier 2 |Part number
CRU CRU
3.0 V battery * 33F8354
Bezel kit * 13N2450
Cable, 24-inch SATA signal * 25R5635
Cable, 400 watt DAS * 25R8849
Shield kit * 13N2997
Service label 43W0417
Cable, panel mount * 13N2413
Cable, diskette drive * 39R8112
Cable, IDE signal * 13N2466
Cable, serial port 2 * 42C1053
EMC I/0 shield * 43W4986
EMC shield kit * 13N2997
Mouse, 2-button * 03N6669
Kit, shield * 13N2997
Kit, bezel * 13N2450
Retainer kit (for optical and diskette drives) * 39R9369
Retention module, fan sync 25R8873
Stabilizing feet * 13N2985

Chapter 4. Hardware Management Console parts
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Table 7. 7310-C06 and 7042-C06 parts listing (continued) (continued)

Description Tier 1 Tier 2 |Part number
CRU CRU

C2 switch * 39Y9783

Miscellaneous Kit (clip, insulator, retainer) * 39Y9773

Modem cable (see |["HMC modem cable part numbers” on page 19)

7042-C07 parts

Machine type 7042-C07 use a personal computer machine type of 4367-32U for its base configuration. To
access the personal computer hardware maintenance manuals, see |“Personal computer parts” on page 11

Note: Each PC hardware maintenance manual may reference more than one machine type in its title. If
necessary, to cross-reference to the original PC hardware maintenance manual, make sure that you find
the hardware maintenance manual for the PC machine type and model for the HMC that you are
servicing.

The following illustration and table identifies the major components that make up the Model 7042-C07.

IPHAU431-0

Figure 5. Model 7042-C07 parts illustration

Notes:
1. Field replaceable units (FRUs) must be serviced only by an authorized service provider.

2. Customer replaceable units (CRUs) can be replaced by the customer. A definition of Tier 1 and Tier 2
CRUs for this model HMC is:

Tier 1 CRU
Uses a procedure that a customer can perform without input from a service provider. The
procedure used to service this type of component is usually required to be done by the
customer.

Tier 2 CRU
Uses a procedure that a customer can perform, but may require support from a service
provider. The procedure used to service this component is usually not required to be done by
the customer.
3. If the part you are replacing is not identified as being either Tier 1 or Tier 2, call your service provider
to service the FRU.
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Table 8. 7042-C07 parts listing

Index |Description Tier 1 Tier 2 |Part number
CRU CRU
1 Chassis assembly, non-redundant power supply, (without diskette 44X0386
drive)
2 Control panel assembly * 44E7571
3 Dual USB connector assembly (cable) * 26K7340
4 Half Height DVD-RAM drive * 43W8467
5 Diskette drive (Shown in drawing but not available on the * N/A
7042-C07)
6 Diskette drive bezel (Shown in drawing but not available on the * N/A
7042-C07)
7 Bezel assembly, upper front * 42C7290
8 Bezel assembly, lower front * 42C7293
9 Hard disk drive, 250 GB SATA, simple swap with tray * 39M4511
Simple Swap disk drive tray * 25R8864
10 Retention bracket, PCI, (front) * 13N2993
EMI shield bracket assembly 44E7337
11 Hard disk drive cage, 3.5-inch * 42C8910
Hard disk drive shield for HDD cage 44X0388
12 Disk drive backplane (for 3.5 inch simple-swap SATA disk drives) * 25R8842
EULER 2.5 Hard disk drive backplane (SATA simple swap) 25R8842
Hard disk drive carrier assembly * 42C7495
13 3.5 inch disk drive air-duct assembly * 39Y9860
14 System board assembly 43W7312
15 SAS/SATA controller * 43V7415
16 Microprocessor, 3.0 GHz dual core, 1333 MHz 44E7588
17 Fan-sink (heatsink) 43W0401
18 Side cover * 25R8836
Side cover with lock * 25R8859
19 Power supply, 401 watt 39Y7330
20 Memory, 512MB * 41Y2725
21 System fan, rear * 25R8829
PSU adapter bracket (not shown) * 42C7509
7042-C07 parts listed in the following table are not illustrated.
Table 9. 7042-CO07 parts listing (continued)
Description Tier 1 Tier 2 |Part number
CRU CRU
3.0 V battery * 33F8354
Bezel kit * 13N2450
Cable, 18-inch SATA signal * 39Y9810
Cable, 401 watt DAS * 25R8849
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Table 9. 7042-C07 parts listing (continued) (continued)

Description Tier 1 Tier 2 |Part number
CRU CRU

EMC shield kit * 13N2997
EMC I/0O shield * 25R8843
System service label * 44E7281
Keylock, keyed-random * 26K7364
Cable, panel mount assembly, SATA * 13N2413
Cable, IDE signal * 13N2466
Cable, serial port 2 * 42C1053
EMC shield kit * 13N2997
PCI-X SCSI Enablement Card * 44F4851
Mouse, 2-button * 03N6669
Kit, bezel * 13N2450
Support and hold down brackets * 41Y9086
Retainer kit (for optical and diskette drives) * 39R9369
Retention module, fan sync 25R8873
Stabilizing feet * 13N2985
C2 switch * 39Y9783
Miscellaneous tray kit (clip, insulator, retainer) * 39Y9773
Modem cable (see ["HMC modem cable part numbers” on page 19)

For a more complete listing of external cabling and power cords for the HMC, refer to latest version of
the Site and Hardware Planning Guide, order number SA76-0091-0x

HMC keyboard CRUs
The keyboards identified in the following table can be attached to any HMC.

Notes:
1. All keyboards are considered a Tier 1 CRU.
2. You must have the specific character set designed for each language installed on your HMC.

Keyboard country code FRU/CRU part number
U.S. English 10N6956
Arabic 10N6984
Belgian/French 89P8302
Belgian/U.K. 10N6969
Bulgarian 10N6972
Brazilian Portuguese 10N6963
Chinese/U.S. 10N6966
Czech 10N6981
Danish 10N6971
Dutch 10N6975
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Keyboard country code FRU/CRU part number
English/EMEA 10N6988
French 10N6957
French Canadian 445 10N6967
French Canadian 58 10N6968
German 10N6959
Greek 10N6977
Hebrew 10N6978
Hungarian 10N6964
Icelandic 89P8317
Italian 141 89P8318
Ttalian 142 10N6958
Japanese 194 10N6962
Korean 10N6965
LA Spanish 10N6983
Norwegian 10N6974
Polish 10N6979
Portuguese 10N6976
Romanian 89P8326
Russian 10N6986
Russian/Cyrillic 898328
Serbian/Cyrillic 89P8329
Slovak 10N6980
Spanish 10N6961
Swedish/Finnish 10N6870
Swiss/French/German 10N6973
Thailand 89P8334
Turkish 440 10N6982
Turkish 179 89P8336
UK. English 10N6960
us. 89P8338
Yugoslav/Latin 89P8339

HMC modem cable part numbers
The following tables contain part number information for HMC modem cables, along with the name of
the country or region where used, and a listing of countries along with the telephone cable name and

part number where used.

If you are using a cable other than one of the cables listed in the following table, read the following
caution statement.

Note: For a more complete listing of external cabling and power cords for the HMC, refer to latest
version of the Site and Hardware Planning Guide, order number SA76-0091-0x
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CAUTION:
To reduce the risk of fire, use only No. 26 AWG or larger (for example, 24 AWG) UL-listed or CSA
certified telecommunication line cord. (C035)

Primary country or region Cable name Cable part number
Austria AUS 21H4902
Australia AUZ 75G3807
Belgium BEL 21H4903
Denmark DN 75G3812
Finland FN 75G3809
France FR 75G3803
Germany GE 75G3804
Hong Kong (S.A.R.) HK 75G3808
Israel ISR 21H4905
Italy 1T 75G3802
Netherlands NL 75G3810
South Africa SAF 21H4904
Sweden SW 75G3806
Switzerland SZ 75G3811
United Kingdom UK 75G3805
United States Us 87G6236

External modems

Contains a list of external modem part number along with the primary country or region where used.

Primary country or region Modem part number
United States 03N7035
Australia 03N7036
Europe 03N7037
United Kingdom 03N7038
China 03N7039
Taiwan 03N7040
All geographies 03N7041
10N8499

Internal modem
When ordering a replacement internal modem for your HMC, use part number 10N8499.
Power cords

The manufacturer provides a power cord with a grounded attachment plug to use with this product. To
avoid electrical shock, always use the power cord and plug with a properly grounded outlet.

Power cords used in the United States and Canada are listed by Underwriter’s Laboratories (UL) and
certified by the Canadian Standards Association (CSA).
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For units intended to be operated at 115 volts: Use a UL-listed and CSA-certified cord set consisting of
a minimum 18 AWG, Type SVT or SJT, three-conductor cord, a maximum of 15 feet in length and a
parallel blade, grounding-type attachment plug rated 15 amperes, 125 volts.

For units intended to be operated at 230 volts (within the U.S.): Use a UL-listed and CSA-certified cord
set consisting of a minimum 18 AWG, Type SVT or SJT, three-conductor cord, a maximum of 15 feet in
length and a tandem blade, grounding-type attachment plug rated 15 amperes, 250 volts.

For units intended to be operated at 230 volts (outside the U.S.): Use a cord set with a grounding-type
attachment plug. The cord set should have the appropriate safety approvals for the country in which
the equipment will be installed.

The power cords listed in the following table are specifically designed for a country or region and are
usually available only in that country or region.

Note: All power cords are considered a Tier 1 CRU.
SRSECNE
N A
@ <> Ny
o m

Index Power cord part number | Used in these countries and regions

1838574 Thailand, Bahamas, Barbados, Bolivia, Brazil, Canada, Costa Rica,
Dominican Republic, Ecuador, El Salvador, Guatemala, Guyana, Haiti,
Honduras, Jamaica, Japan, Netherlands Antilles, Panama, Peru, Philippines,
Taiwan, Trinidad (West Indies), Tobago, United States of America,
Venezuela

6952301 Bahamas, Barbados, Bermuda, Bolivia, Brazil, Canada, Cayman Islands,
Colombia, Costa Rica, Dominican Republic, Ecuador, El Salvador,
Guatemala, Guyana, Haiti, Honduras, Jamaica, Japan, Korea (South),
Liberia, Mexico, Netherlands Antilles, Nicaragua, Panama, Peru,
Philippines, Saudi Arabia, Suriname, Taiwan, Trinidad (West Indies),
United States of America, Venezuela

13F9940 Argentina, Australia, China (PRC), New Zealand, Papua New Guinea,
Paraguay, Uruguay, Western Samoa
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Index

Power cord part number

Used in these countries and regions

13F9979

Afghanistan, Algeria, Andorra, Angola, Austria, Belgium, Benin, Bulgaria,
Burkina Faso, Burundi, Cameroon, Central African Rep., Chad, China
(Macau S.A.R.), Czech Republic, Egypt, Finland, France, French Guiana,
Germany, Greece, Guinea, Hungary, Iceland, Indonesia, Iran, Ivory Coast,
Jordan, Lebanon, Luxembourg, Malagasy, Mali, Martinique, Mauritania,
Mauritius, Monaco, Morocco, Mozambique, Netherlands, New Caledonia,
Niger, Norway, Poland, Portugal, Romania, Senegal, Slovakia, Spain,
Sudan, Sweden, Syria, Togo, Tunisia, Turkey, former USSR, Vietnam, former
Yugoslavia, Zaire, Zimbabwe

13F9997

Denmark

14F0015

Bangladesh, Burma, Pakistan, South Africa, Sri Lanka

14F0033

Antigua, Bahrain, Brunei, Channel Islands, China (Hong Kong S.A.R.),
Cyprus, Dubai, Fiji, Ghana, India, Iraq, Ireland, Kenya, Kuwait, Malawi,
Malaysia, Malta, Nepal, Nigeria, Polynesia, Qatar, Sierra Leone, Singapore,
Tanzania, Uganda, United Kingdom, Yemen, Zambia

14F0051

Liechtenstein, Switzerland

14F0069

Chile, Ethiopia, Italy, Libya, Somalia

10

14F0087

Israel
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Chapter 5. Cabling the HMC

Connect the Hardware Management Console (HMC) cables, connect the Ethernet cable, and connect the
HMC to a power source.

If the physical HMC is not located within 8 meters (25 feet) away from the managed system, you must
supply a separate system that can access the Internet using a Web browser. This system must be within 8
meters (25 feet) of the managed system. This setup allows service personnel remote access to the HMC.
The HMC must also be configured to allow for this remote access.

DANGER

Electrical voltage and current from power, telephone, and communication cables are hazardous.

To avoid a shock hazard:

* Do not connect or disconnect any cables or perform installation, maintenance, or reconfiguration
of this product during an electrical storm.

* Connect all power cords to a properly wired and grounded electrical outlet. Ensure outlet
supplies proper voltage and phase rotation according to the system rating plate.

e Connect any equipment that will be attached to this product to properly wired outlets.
* When possible, use one hand only to connect or disconnect signal cables.
* Never turn on any equipment when there is evidence of fire, water, or structural damage.

* Disconnect the attached power cords, telecommunications systems, networks, and modems before
you open the device covers, unless instructed otherwise in the installation and configuration
procedures.

* Connect and disconnect cables as described below when installing, moving, or opening covers on
this product or attached devices.

To Disconnect:

1. Turn everything OFF (unless instructed otherwise).
2. Remove power cords from the outlet.

3. Remove signal cables from connectors.

4. Remove all cables from devices.

To Connect:

1. Turn everything OFF (unless instructed otherwise)
2. Attach all cables to devices.

3. Attach signal cables to connectors.

4. Attach power cords to outlet.

5. Turn device ON.

(D005)

Use the following instructions to help you cable your rack-mounted or stand-alone HMC.

Attention: Do not plug the power cords into the electrical outlet until you are instructed to do so.
1. Ensure that you position the HMC in the correct location.
2. Choose from the following options:

* If you are installing a rack-mounted HMC, continue with step
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 If you are installing a stand-alone HMC, continue with step @
3. Perform the following steps to install the cables on a rack-mounted HMC:

a. Use the following illustration to identify the location of the connectors described in these
instructions:

AC Power
LED
Power connector
PCl slot 1 PCI slot 2
EE0o0o| - \ = ==\ T —
et ] ,,c \@\
EsEnt R EToRTC 60 o N\ NSNS
/] 4
Ethernet 1 / Video \ Power-on LED
USB 2 connector \ System-locator LED °
Ethernet 2 USB 1 System-error LED §
Systems Serial DC Power é
management B

Ethernet connector °™M€tO" LED

Figure 6. Back view of a typical rack-mounted HMC

b. If you are installing your HMC into a rack, see the latest level of the Installation and Confiquration
Guide for the Hardware Management Console, order number SA76-0084. When you are finished
installing the HMC into a rack, continue with the next step.

c. Connect the keyboard, display, and mouse using the USB conversion option cable.
d. Continue with step
4. If you are installing a stand-alone HMC, perform the following steps:

a. Use the following illustration to identify the location of the connectors described in these
instructions:

1
Power cord \J"\@ o
. @
Serial 2
Mouse
\ C
Keyboard —_J

Serial 1 —_|
Parallel
Video — |

USB (2) —
Ethernet;
USB (2)

Systems /

management
Ethernet

AREA3550-1

Figure 7. Back view of a typical stand-alone (tower) HMC
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Table 10. Supported HMC ports
Port

Video

PS/2 Keyboard/Mouse

Serial 1
USB

Ethernet

Description
The Video port is used as monitor connection.

A PS/2 keyboard or mouse is not included with the
HMC, but you can attach either.

Serial 1 is supported for an external modem.

These ports are supported for a USB keyboard, mouse,
flash memory, or USB diskette drive.

The Ethernet port is used as the HMC’s primary network
connection.

The HMC does not support the use of parallel, Serial 2, or systems management Ethernet ports.

Attach the monitor cable to the monitor connector, and tighten the screws.
Attach the power cord to the monitor.

d. Ensure that the voltage selection switch on the HMC is set to the voltage used in your world
region. The voltage selection switch is red and is located near the power connector. Move the
switch so that the voltage used in your world region is displayed.

e. Plug the power cord into the HMC.

f. Connect the keyboard and mouse to the Universal Serial Bus (USB) ports on the HMC. You can
connect the keyboard and mouse to the USB ports on the front or back panels.

Connect the modem:

Note: During the installation and configuration of the HMC, the modem might automatically dial
out as the HMC follows routine call-out procedures. This is usual behavior.

If you are connecting an external modem, do the following:

a. Optional: Install the external modem into a rack.

b. If you have not already done so, connect the modem data cable to the external HMC modem.

c. Connect the modem data cable to the system port on the HMC labeled with the following symbol:

IPHA EZ20
d. Use the telephone cable to connect the line port of the external modem to the analog telephone
jack on your wall.

If you are connecting to an integrated modem, use the data cable to connect the integrated HMC modem
to the appropriate data source. For example, use the telephone cable to connect the HMC modem line
port to the analog jack on your wall.

Connect the Ethernet (or crossover) cable from the HMC to the managed server.

Note:

¢ In general, connect your HMC to the managed server in a private service DHCP network. If you
have not installed any additional Ethernet adapters in the PCI slots on your HMC, use the primary
integrated Ethernet port. Use the previous illustrations to identify the location of the HMC ports.
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* You can verify that the Ethernet cable connection is active by observing the green status lights at
both the HMC and managed system Ethernet ports while your installation progresses.

* Connect the Ethernet port on the HMC to the Ethernet port that is labeled HMC1 on the managed
server.

If you are connecting a second HMC to your managed server, connect to the Ethernet port that is
labeled HMC2 on the managed server.

7. If you use an external modem, plug the modem power supply cord into the HMC modem.
8. Plug the power cords for the monitor, HMC, and HMC external modem into electrical outlets.

Note: Do not connect the managed system to a power source at this time.

9. If you are setting up the HMC to manage an existing server, continue with [Preparing for HM(]
fconfiguration” on page 54

Note: For a complete list of HMC supported external cables, refer to the [Serial attached SCSI cable]
I’ &
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Chapter 6. Troubleshooting the HMC

Learn how to correct a No connection, Incomplete, Recovery, or Error state on a system managed by an

HMC.

Correcting a No connection state for a managed system

The No connection state can occur when the HMC is not connected, or the connection with the managed
system failed.

Use this procedure for a system that was previously connected to the same HMC and is now in No
connection state. If you have a new system, a new HMC, or have moved your system to a different HMC,
refer to [“Correcting a connection problem between the HMC and a managed system” on page 31

1. Obtain the IP address for the managed system’s service processor by performing the following steps.

a.

b.

On the HMC, right-click the desktop and select terminal > rshterm. The restricted shell command
line interface opens.

At the terminal, issue the command: Tssysconn -r all
Information similar to the following is displayed:

resource_type=sys,type_model_serial_num=9117-570*100729E, sp=unavai
lable,ipaddr=10.0.0.247,alt_ipaddr=unavailable,state=No Connection,conne
ction_error_code=Connecting 0000-0000-00000000

At the terminal, issue the ping command to the address of the failing system. In the previous
example, you would type: ping 10.0.0.247.

2. Choose from the following options:

* If the ping is successful, go to step

e If the ping is not successful, go to step @

3. If the ping test is successful, perform the following steps:

a.

If your system is equipped with a control panel, ensure that there are no steady (nonscrolling)
reference codes displayed on the panel.

Note: A steady reference code might indicate a hardware problem. Contact your next level of
support or your hardware service provider.

b. Restart the HMC.

c. If restarting the HMC does not resolve the problem, contact your next level of support or your

hardware service provider.

4. If the ping test is not successful, perform the following steps:

a.

If your system is equipped with a control panel, ensure that there are no steady (nonscrolling)
reference codes displayed on the panel.

Note: A steady reference code might indicate a hardware problem. Contact your next level of
support or your hardware service provider.

b. If your system has a control panel, check to see if the power light is on.

c. Choose from the following options:

* If there is power to the managed system, go to step

e If there is no power to the managed system, refer to [“HMC and system power on and power off]
[procedures” on page 32| After the power is restored, wait 5 minutes for the service processor to
restart and the HMC to re-establish contact. If the system is equipped with redundant service
processors, allow up to 20 minutes for this step.
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5. Verify physical network connectivity by performing the following steps:

6.

a. Verity that the HMC and the service processor are correctly connected to your Ethernet network.

b. Verify that Ethernet link status is good on all network segments which exist between the HMC
and the managed system.

c. If you think the network might be the problem, connect a cable from the HMC to the service
processor and try pinging the failing system. Then choose from the following options:

* If the ping is successful, replace the cables the way they were and correct the network problem.
After the network problem is resolved, repeat this entire procedure.

* If the ping is not successful, replace the cables the way they were and continue with step

d. Reset the service processor. See [“Resetting the service processor” on page 32

If the problem is not resolved by any of the above steps, contact your next level of support or your
hardware service provider.

Correcting an Incomplete state for a managed system

The Incomplete state can occur when the HMC failed to get all of the necessary information from the
managed system.

To correct an Incomplete state, perform the following steps:

1.

~

From the navigation area, select Servers.

2. From the contents area, select the managed system.
3.
4. Choose from the following options:

Select Tasks > Operations> Rebuild Managed System.

* If the state remains as Incomplete, rebuild the managed system several more times.

« If the state goes to Recovery, see [“Correcting a Recovery state for a managed system.”|

 If the state does not remain as Incomplete or go to Recovery, continue with the next step.

Reset the connection from the HMC. See [“Resetting the managed system connection from the HMC”]

If the connection still fails, continue with the next step.

Restart the HMC. Then choose from the following options (This next step might take several minutes
to complete):

« If the state goes to Recovery, see [“Correcting a Recovery state for a managed system.”|

¢ If the state remains Incomplete, perform the following steps:
a. Verify that there is a redundant HMC.
b. Verify that no one is entering commands from the alternate HMC.
C. Repeat step |1| through El If the connection still fails, continue with the next step.

. If the problem persists, contact your next level of support or your hardware service provider.

Correcting a Recovery state for a managed system

The Recovery state can occur when the save area in the service processor assembly is not synchronized
with the HMC database.

To recover from the Recovery state, perform the following steps:

1.

Recover partition data. For details, see [“Recovering partition data on a managed system” on page 29|
If this resolves the problem, this ends the procedure.

If the problem is not resolved after recovering profile data, choose one of the following;:

* If the state remains in Recovery , retry recovering partition data. If it fails a second time, follow the
problem determination procedure for any reference codes you receive.
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« If the state changed to Incomplete, refer to [“Correcting an Incomplete state for a managed system” on|
-ae 28.

+ If the state changed to No Connection, refer to [“Correcting a No connection state for a managed|
lsystem” on page 27/

* If the problem persists, contact your next level of support or your hardware service provider.

Recovering partition data on a managed system

Learn how to recover the partition data on your managed system if the partition becomes corrupted.

Through the HMC interface, you can recover partition data on your managed system if the data becomes
damaged. This partition data includes information about logical partitions, partition profiles, and system
profiles. If the partition data on your managed system becomes damaged, the managed system is in
Recovery state. You can either restore the partition data from a backup file that is saved automatically on
your HMC, or clear all partition configuration.

This procedure recovers the partition data in the service processor of your server. To recover the partition
data on your managed system, see [‘Restoring profile data.”]

Note: The HMC might not show operating state for the managed system after completing this recovery
procedure. After a partition is activated, the managed system changes to an operating state and clears the
A700 4091 or C700 4091 system reference code (SRC).

To recover the partition data on your managed system, you must be a member of one of the following
roles:

¢ Super administrator
* Operator

To recover the partition data on your managed system, do the following;:
1. In the Navigation Area, open Server and Partition.
2. Select Server Management.

3. In the contents area, right-click the managed system whose partition data you want to recover and
select Recover Partition Data.

4. Select one of the following:

* Restore profile data from HMC backup data: This option restores the partition data using the
backup file that is saved automatically on the HMC.

* Initialize the managed system: This option clears all partition configuration data, and can only be
used if all partitions are in the Not Activated state.

5. Click OK.

Restoring profile data

Learn how to read the profile data from the previously backed-up file on the HMC, and load this data to
the managed system.

Selecting this menu item restores profile data to the HMC from a backup file stored on the HMC hard
drive.

Note: This is not a concurrent procedure. When the data is restored, the managed system powers on to
Partition Standby.

To restore stored profile data on the HMC hard drive, you must be a member of one of the following
roles:
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* Super administrator

* Service representative

To restore profile data, do the following:

1.

In the Contents area, select the managed system.

2. From the menu, select Selected > Profile Data > Restore.

ok w

From the list of backup files, select the profile information that you want to restore .
Select a restore option.
Click OK.

Correcting an Error state for a managed system

The Error state automatically generates a call to the service support center if the automatic call support
function is enabled.

If the automatic call support function is not enabled, contact your next level of support or your hardware
service provider.

Correcting a Failed Authentication state for a managed system

The Failed Authentication state can occur when the HMC access password for the managed system is not
valid.

Perform the following procedure to correct a failed authentication state on your HMC.

1.

Do you have an HMC password?
* Yes: Enter the HMC password and choose from the following options:

— If the managed system goes to Operating, Power Off, or Standby, the authentication was
successful. This ends the procedure.

— If the managed system goes to No connection, Incomplete, Recovery, or Error state, refer to
[Chapter 6, “Troubleshooting the HMC,” on page 27

* No: Do you have an ASMI admin password?

- Yes: Continue with step El

— No: Contact your next level of support to request CE login. Then continue with step [2, using CE
login instead of admin password for step

Perform the following steps:

a. Log in to the ASMI with admin authority.
Select Login Profile.

Select Change Password.

In the User ID to change field, select HMC.

Enter the ASMI’s admin password in the Current Password for user ID admin field.

® oo o

Note: Do not enter the HMC user password. Enter the ASMI’s admin password.
f. Enter a new HMC access password twice and click Continue.
g. From the HMC Server Management window, select Update the managed system password.
h. Enter the new password that was set in step @ This ends the procedure.

3. If the problem is not resolved, contact your next level of support or your hardware service provider.
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Correcting a connection problem between the HMC and a managed
system

Learn how to correct a connection problem between the HMC and a managed system.

Use this procedure in the following situations:

* You have a new HMC

* You have a new system

* You are using a different HMC to manage your system.

If your system was previously connected to the same HMC and is now in No connection state, refer to
[‘Correcting a No connection state for a managed system” on page 27

1. Choose from the following options:
¢ If the system uses DHCP addressing, go to step EI
* If the system uses static addressing, go to step El

Note: To find out if your system uses DHCP or static addressing, perform one of the following:

* Use the ASMI by selecting Network Services » Network Configuration and viewing whether the
IP address field shows Static or Dynamic.

* If you have a control panel, use function 30.

2. If your system uses DHCP addressing, add a system automatically by issuing the following
command: mksysconn -o auto.

Is the system displayed?
* Yes: This ends the procedure.
* No: Continue with step EI
3. Check for network problems, cables, switches, link lights on the service processor, and so on.
Was there a problem?
* Yes: Correct the problem and return to step El
* No: Continue with step El

4. Reset the service processor to force it to request a new IP address. Refer to[‘Resetting the service]
[processor” on page 32

5. Did resetting the service processor resolve the problem?
* Yes: This ends the procedure.
* No: Contact your next level of support.
6. If your system uses static IP addressing, add a system manually by performing the following steps:
a. From the HMC, select Server Management.
b. Select Add Managed System.
c. Click Add a managed system.
d. Enter the IP address/Hostname and password.
Is the system displayed under system management?
* Yes: This ends the procedure.

* No: Contact your next level of support.
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Resetting the managed system connection from the HMC

Use this procedure to reset the managed system connection from the HMC.

Perform these steps to reset the managed system connection:

In the navigation area, open Systems Management.

Select Servers.

In the contents area, select the server on which you want to reset the connection.
In the Tasks area, open Connections.

Select Reset or Remove Connection.

Select Reset Connection.

Click OK.
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Resetting the service processor

Use this procedure to reset the service processor.

Note: Use this procedure only under the direction of your next level of support or your hardware service
provider. During this procedure, you will be powering off the system and removing and reapplying ac
power.

1. Inform anyone using the server that it will be shut down.
2. Stop all applications that are running on the server.
3. Stop the operating system and server by choosing from the following options:

* If you have an HMC, shut down all logical partitions and the server. For instructions, see m
land system power on and power off procedures.”| Then continue with step

* If you do not have an HMC, continue with the next step.
4. Log in to the system as a user with the authority to run the appropriate shutdown command.
5. At the command line, enter one of the following commands:
« If your system is running the AIX® operating system, type shutdown
* If your system is running the IBM i operating system, type PWRDWNSYS *IMMED
« If your system is running the Linux® operating system , type shutdown -h now
These commands stop the operating system. The system power turns off, the power-on light begins to
slowly blink, and the system goes into a standby state.
6. Unplug the ac power cord and then plug it back in.
7. Start the server. The service processor is reset. This ends the procedure.

HMC and system power on and power off procedures

Use one or more of the following procedures to power on or power off your HMC or system.
Power on the HMC

During the process of powering on, the HMC checks to see which managed systems are available and
communicating with the console. To ensure that each managed system is available before you power on
the HMC, managed systems must be in standby mode or actively operating. Standby mode is indicated
by the 0K shown in the operator panel after the managed system has the power connected and the initial
tests are complete.

Note: If the managed system is in an emergency power off (EPOW) condition, the managed system must
be brought to standby mode before the HMC can be used to power on the system.
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To power on the HMC, do the following:
1. Press the Power button once to turn on the power.
2. When the system has finished the power-on self-test (POST), log in to the HMC.

Power off the HMC

Attention: If possible, shut down all applications and partitions before powering off the system. Using
either the power-on button on the control panel or entering commands at the HMC to stop the system
can cause unpredictable results in the data files. Also, the next time you start the system, it might take
longer if all applications are not ended before stopping the system.

To power off the HMC, log in to the HMC and select Power off. The HMC shuts down any applications
that are running, and then turns off the HMC.

Power-on self-test

After power is turned on and before the operating system is loaded, the system does a power-on self-test
(POST). This test performs checks to ensure that the hardware is functioning correctly before the
operating system is loaded. During the POST, codes indicating the progress of the POST might be
displayed. After the POST is complete, the HMC operating machine code loads and a login prompt is
displayed.

Power on a system using an HMC

To power on a managed system, complete the following steps:
1. In the Navigation area, expand the Systems Management icon.
2. Expand the Servers icon.

3. Select the check box next to the name of the desired server. The tasks available for that server will be
enabled.

4. From the Tasks menu, choose Operations -> Power on. Follow any additional on-screen instructions.
Power off a system using an HMC

Attention: If possible, shut down the running logical partitions on the managed system before powering
off the managed system. Powering off the managed system without shutting down the logical partitions
first causes the logical partitions to shut down abnormally and can cause data loss.

1. In the Navigation area, expand the Systems Management icon.
2. Expand the Servers icon.

3. Select the check box next to the name of the desired server. A selection of tasks available for that
server will be displayed.

4. From the Tasks menu, select Operations > Power off. Follow any additional on-screen instructions.

5. Continue with ["Remove the power cords” on page 34|

Install the power cords

Before powering on a system, ensure that the power cords have been plugged in to all of the power
supplies on all of the processor enclosures.

Install the cords in the following order:
1. Secondary 2

2. Secondary 3

3. Primary
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4. Secondary 1
Remove the power cords

The system might be equipped with a second power supply. Before continuing with this procedure,
ensure that all power sources to the system have been completely disconnected.

1. Unplug any power cables that are attached to the unit from electrical outlets.

2. Remove all power cords from all of the processor enclosures starting with the primary processor
enclosure (topmost) and then each secondary enclosure working from top to bottom.

Reinstalling the HMC machine code

Explains how to reinstall the interface and HMC machine code prior to restoring critical backup data.

If the HMC is not responding, you can use the recovery CD to reinstall the HMC onto the HMC PC.
After you reinstall the HMC machine code, you can restore the backup data that you created to recover
your critical console information. For information about how to restore the HMC backup data, see
[‘Restoring critical HMC data” on page 35/

To reinstall the HMC machine code, you must be a member of one of the following roles:
* super administrator
* operator

* service representative

Note: If the F12 function key is not enabled, see |[“Setting up the network interface as a startup device” on|

to enable it.

To reinstall the HMC machine code, do the following:

1. Shut down and power off the HMC. If necessary, see [“Shutting down, logging off, and disconnecting]
[the HMC” on page 55

2. If you are installing the HMC interface or machine code from the network , go to step 3. If you are
installing the HMC interface or machine code from recovery media, do the following:

a. Install the recovery media.

b. Power on the HMC. The HMC powers on from the media and displays the Backup/Upgrade/
Restore/Install window.

Select the Install option, and click Next.
Select Install from media. Click Next.
When prompted to install the additional media. Select 1 - Install additional software from media.
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Select 1 - Restore Critical Console Data from the menu to restore data from a DVD. This
completes this procedure.

3. Prior to reinstalling the HMC interface or machine code from a network ensure the following is in
place:

a. The network boot server must be configured.

b. The network interface is one of the devices in your startup sequence. To view the list of startup
devices, press F12 when the HMC powers on, and select the network interface from which you
want to boot

4. To install the HMC interface or machine code from a network, do the following:
a. Select the Install option, and click Next.
b. Select Install from network. Click Next.

c. To finish the restore from a remote server, select 2 - Finish the Installation.
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Back up partition profiles

Refer to this procedure when needing to back up a partition profile.

To back up partition profile data, you must be a member of one of the following roles:
* super administrator

* service representative

To back up partition profile data, do the following:

1. In the Contents area, select the managed system.

2. From the menu, click Selected > Profile Data > Backup.
3. Type the name you want to use for this backup file.

4. Click OK.

Restoring critical HMC data
Restore critical HMC data.

Restore HMC backup data only in conjunction with a reinstallation of the HMC. For information about
how to reinstall the HMC, see [“Reinstalling the HMC machine code” on page 34

Note: For this operation, you must have one of the following;:
¢ The backup DVD media

* Access to the remote server where the archive was created by using the procedure in
[critical HMC data” on page 53|

To restore the HMC data, you must be a member of one of the following roles:
* super administrator
* operator

* service representative
Select the data-restoration procedure based on the data archiving method used:

If the critical console data has been archived on a DVD, do the following:

1. Select 1 - Restore Critical Console Data from the menu displayed at the end of the HMC
reinstallation.

2. Insert the DVD containing the archived console data. On the first boot of the newly installed HMC,
the data is automatically restored.

If the critical console data from a remote server, do the following:

1. Manually reconfigure network settings to enable access to the remote server after the HMC is newly
installed. For information about configuring network settings, see Configuring the HMC.

In the Navigation area, click the Licensed Internal Code Maintenance icon.
In the Contents area, click the HMC Code Update icon.
Select Restore Remote Console Data.

Select the type of remote restoration.
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Follow the directions on the window to restore the critical console data. The data automatically
restores from the remote server when the system is rebooted.
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Setting up the network interface as a startup device

This section describes how to enable the F12 function key to set up the network interface as a startup
device.

On some HMC models, the F12 function key is not enabled for use when the HMC is powered on. These
steps enable the F12 function key so that you can specify the network interface as a startup device.

To set up the network interface as a startup device, you must be a member of one of the following roles:
* super administrator
* operator

* service representative

To set up the network interface as a startup device, do the following:

1. Shut down and power off the HMC. For more information, see [‘Shutting down, logging off, and|
[disconnecting the HMC” on page 55/

Power on the HMC console.

Press F1 to start the BIOS Setup utility.

Find and select Startup or Start Options.

Select Startup Sequence to view the list of startup devices.
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Depending on the type of HMC (stand-alone or rack-mounted), use the +/- key or arrow key to make
the network interface an entry in the startup list, after the hard disk.

7. 1f the HMC is a stand-alone model, find and enable the Start up Device Menu prompt. This enables
the F12 function key when the HMC powers on, so that you can select the network device in your
startup list.

For CR2 and CR3 machine types, the Planar Ethernet PXE/DHCP entry should have Planar Ethernet
1 and Planar Ethernet 2.

On desktop HMC machines, do the following;:
a. Press Esc.
b. Select Devices -> Network Setup.

c. Ensure that PXE Boot Agent and PXE Base code are set to Enabled. If these settings are not
enabled, networking will not occur.

8. Save the settings and exit the BIOS setup utility to restart the boot process.

You can now press F12 to select the network device as the startup device. If a DHCP server can accept
PXE requests from the HMC, and has the required files, the HMC will boot from it. The
Backup/Upgrade/Restore/Install window opens.

The chhmc command can be used on some HMC machine types to set the network interface as a startup
device. To enable network boot on the HMC, use the following command:

chhmc -c netboot -s enable

When the command completes, run the following command to verify that network boot has been
enabled:

Ishmc -r
The command then displays the following:

ssh=enable,xntp=disable,websm=enable,http=enable,netboot=enable
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To disable network boot, use the chhmc command:

chhmc -c netboot -s disable

Upgrading the machine code on an HMC from Version 6 to Version 7

Learn how to upgrade the machine code on an HMC from Version 6 to Version 7 while maintaining your
HMC configuration data.

Perform Steps 1 through 9 to upgrade machine code on an HMC from Version 6 to Version 7.

Important: You must be at a minimum of HMC machine code Version 6 Release 1.2 to upgrade to
Version 7 Release 3.1.0.

Step 1. Obtain the upgrade

You can order the HMC machine code upgrade through the Fix Central Web site, by contacting service
and support, or by downloading it to an FTP server.

Note: If you do not have access to the Internet, contact service and support to order the upgrade on
DVD.

1. From a computer or server with an Internet connection, go to the Fix Central Web site at

[http:/ /www.ibm.com/eserver/support/ fixes/ I-lﬁ" .
Select the appropriate family in the Product family list.

Select Hardware Management Console in the Product or fix type list.
Click Continue. The Hardware Management Console site is displayed.
Navigate to the HMC version that you want.

Locate the Recovery CD download and ordering section.

Follow the on-screen prompts to submit your order.
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After you receive the upgrade, continue with [’Step 2. Back up critical console information.”]

Step 2. Back up critical console information

Back up critical console information before installing a new version of HMC software so that previous
levels can be restored in the event of a problem while upgrading the software. Do not use this critical
console data after a successful upgrade to a new version of the HMC software.

Note: If you choose to back up the console data to removable media (that is, diskette or DVD), you will
need to have a diskette or DVD available.

1. Choose from the following options:
* If you do not plan to back up to diskette or DVD-RAM, continue with the next step.
* If you plan to back up to diskette or DVD-RAM, perform the following steps:
a. Insert the media into the drive.
Select Format Removable Media.
Select Format DVD-RAM or Format diskette.
Click OK.

e. Continue with the next step.
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2. Select Back up Critical Console Data.
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3. Select an archive option. You can back up to a DVD in the HMC, a remote system mounted to the

4.

HMC file system (for example, NFS), or send the backup to a remote site using File Transfer Protocol
(FTP).

* To back up to DVD, choose Back up to DVD on local system and follow the instructions.

* To back up to a mounted remote system, choose Backup to mounted remote system and follow the
instructions.

* To back up to a remote FTP site, choose Send backup critical data to remote site and follow the
instructions.

Continue with [“Step 3. Record the current HMC configuration information.”]

Step 3. Record the current HMC configuration information

Before you upgrade to a new version of HMC software, as a precautionary measure, record HMC
configuration information.

To record HMC configuration information, follow these steps:

1.
2.
3.

In the navigation area, open HMC Management.
Select HMC Configuration.

In the tasks list, select Schedule Operations. The Scheduled Operations window opens with a list of
all managed systems.

Select the HMC you plan to upgrade and click OK. All scheduled operations for the HMC are
displayed.
Select Sort » By Object.
Select each object and record the following details:
¢ Object Name
* Schedule date
* Operation Time (displayed in 24-hour format)
* Repetitive (if Yes, perform the following steps:)
a. Select View » Schedule Details.
b. Record the interval information.
c. Close the scheduled operations window.
d. Repeat for each scheduled operation.

Close the Customize Scheduled Operations window.

Continue with |“Step 4. Record remote command status.”|

Step 4. Record remote command status

ook wn =

In the navigation area, select HMC Management.

Select HMC Configuration.

In the tasks list, click Enable/Disable Remote Command Execution.

Record whether the Enable remote command execution using the ssh facility check box is selected.
Click Cancel.

Continue with [“Step 5. Save upgrade data.”|

Step 5. Save upgrade data

You can save the current HMC configuration in a designated disk partition on the HMC. Only save
upgrade data immediately prior to upgrading your HMC software to a new release. This action allows
you to restore HMC configuration settings after upgrading.
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Note: Only one level of backup data is allowed. Each time you save upgrade data, the previous level of
data is overwritten.

1. In the navigation area, open the Licensed Internal Code folder.
Select HMC Code Update.

Select Save Upgrade Data.

Select Hard Drive and click Continue.

Click Continue to start the task.

Wait for the task to complete. If the Save Upgrade Data task fails, contact your next level of support
before proceeding.
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Note: If the save upgrade data task fails, do not continue the upgrade process.
7. Click OK.
8. Click Close.
9. Continue with [“Step 6. Upgrade the HMC software from Version 6 to Version 7.”|

Step 6. Upgrade the HMC software from Version 6 to Version 7

To upgrade the HMC software, do the following:
1. Insert the HMC Product Installation DVD-RAM into the DVD-RAM drive.
2. Select Upgrade and click Next.
3. When the message is displayed, choose from the following options:
* If you have saved upgrade data during the previous task, continue with the next step.

* If you did not save upgrade data previously in this procedure, you must save the upgrade data
now before you continue.

4. Select Upgrade from media and click Next.

o

Confirm the settings and click Finish.
6. Follow the on-screen prompts.

Note:
 If the screen goes blank, press the space bar to view the information.
* The first DVD can take approximately 20 minutes to install.
7. When prompted, remove the first media and then insert the second media into the DVD-RAM drive.

8. Select 1. Install additional software from media and press Enter. Press any key to confirm the
installation. The HMC will display status messages while it installs the packages.

9. When the second media installation is complete, remove the media from the drive and close the
drawer.

10. Select Option 2 Finish the installation and press Enter. The HMC will complete the booting process.
11. Accept the License Agreement for Machine Code twice.

12. At the login prompt, log in using your user ID and password. The HMC code installation is
complete.

13. Continue with [“Step 7. Verify that the HMC machine code upgrade installed successfully.”|

Step 7. Verify that the HMC machine code upgrade installed

successfully

1. Verify that the version and release match the update that you installed.

2. If the level of code displayed is not the level that you installed, perform the following steps:
a. Retry the update using a different DVD.
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b. If the problem persists, contact your next level of support.

HMC problem analysis

Use this information to diagnose and repair problems that are related to the Hardware Management
Console (HMCQ).

DANGER

When working on or around the system, observe the following precautions:

Electrical voltage and current from power, telephone, and communication cables are hazardous. To

avoid a shock hazard:

* Connect power to this unit only with the IBM provided power cord. Do not use the IBM
provided power cord for any other product.

* Do not open or service any power supply assembly.

* Do not connect or disconnect any cables or perform installation, maintenance, or reconfiguration
of this product during an electrical storm.

* The product might be equipped with multiple power cords. To remove all hazardous voltages,
disconnect all power cords.

* Connect all power cords to a properly wired and grounded electrical outlet. Ensure that the outlet
supplies proper voltage and phase rotation according to the system rating plate.

* Connect any equipment that will be attached to this product to properly wired outlets.

* When possible, use one hand only to connect or disconnect signal cables.

* Never turn on any equipment when there is evidence of fire, water, or structural damage.

* Disconnect the attached power cords, telecommunications systems, networks, and modems before
you open the device covers, unless instructed otherwise in the installation and configuration
procedures.

* Connect and disconnect cables as described in the following procedures when installing, moving,
or opening covers on this product or attached devices.

To Disconnect:

1. Turn off everything (unless instructed otherwise).
2. Remove the power cords from the outlets.

3. Remove the signal cables from the connectors.

4. Remove all cables from the devices

To Connect:

1. Turn off everything (unless instructed otherwise).
2. Attach all cables to the devices.

3. Attach the signal cables to the connectors.

4. Attach the power cords to the outlets.

5. Turn on the devices.

(D005)

If you were directed here from the Beginning problem analysis procedure because your HMC is not
functioning correctly, continue with the [“Entry point for HMC problem determination” on page 41

To perform other maintenance tasks on your HMC, refer to the following procedures:

* For general maintenance information on the base personal computer that is used to build the HMC, see
[Chapter 2, “Diagnostics,” on page 5

¢ For instructions to replace an HMC, see [Replacing an HMC|

* For HMC parts information, refer to the following:

— [Hardware Management Console (HMC) parts| Because the personal computer that is used for your
HMC can be serviced by the customer, you are the service provider for your HMC.
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— To find links to the appropriate personal computer hardware maintenance information, see

[“Equivalent maintenance information for the HMC personal computer hardware” on page 5|

* For removing and replacing HMC parts, see [Chapter 3, “Removal and replacement procedures,” on|

* For backing up critical disk drive information on the HMC, refer to the [Backing up critical HMC data|

topic.

* For restoring disk drive information on the HMC, refer to [Reinstalling the HMC machine code| .

* For checking modem settings, refer to the [Cabling the HM(] topic.

Entry point for HMC problem determination

Find the symptom you are having in the Symptom column of the following table. Then perform the
action described in the Action column.

Symptom

Action

Operator reported that the HMC did
not start, but no other problems were
reported.

Go to ["Beginning HMC problem determination” on page 42|

Operator reported “Communication
not active” on the HMC.

Go to ['Testing the HMC Ethernet adapter” on page 46

Operator reported communication
problems with a remotely connected
HMC or a managed system.

Go to|‘Testing the modem connection to the managed system” on page 44|

Power problems

Go to[‘Testing for a power problem” on page 43|

HMC boot problems

Go to[“Beginning HMC problem determination” on page 42|

Display problem

Go to|“Testing the HMC display” on page 50

DVD-RAM drive problem

Go to|“Testing the HMC DVD-RAM Drive” on page 48

Diskette drive problem

Go to |[“Testing the HMC diskette drive” on page 49|

Ethernet LAN problem

Go to[“Testing the HMC Ethernet adapter” on page 46|

A problem with any of the following:
* display

e diskette drive

* DVD-RAM Drive

* disk drive

* Ethernet LAN

Go to|“Performing system unit testing using PC-Doctor” on page 44

Eight character error code beginning
with HMC was received when using
the HMC graphical user interface.

Go to the [“Service request numbers” on page 5|

HMC does not communicate through
the modem.

Go to|“Testing the HMC modem connection” on page 44

PC-Doctor diagnostic tests detected
an error.

For PC hardware maintenance manuals to help isolate the problem to a
failing part, refer to[“Equivalent maintenance information for the HM(|
[personal computer hardware” on page 5

Problems understanding the usage of
the HMC.

Go to Operations Guide for the HMC and Managed Systems, order number
SA76-0085-0x.

All other problems (for example:
HMC GUI is unresponsive, parity
errors, power, POST codes, blank
display, mouse, or keyboard).

Go to|[“Beginning HMC problem determination” on page 42|
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Symptom Action

Symptoms not in this list. Go to [“Beginning HMC problem determination.”]

Beginning HMC problem determination

Use this procedure to determine if there is a problem with the HMC hardware. This procedure might
direct you to procedures in various sections of this information or to personal computer maintenance
information.

Step 1. HMC problem determination

1. If the HMC is running, shut down the console by exiting the graphical user interface. The PC power
turns off automatically. If the PC cannot turn off the power, then turn the power switch off.

2. Turn on the HMC power.

3. Watch the console and allow enough time for the system to complete the POST and load the HMC
machine code.

4. Watch and listen for the following failing symptoms during power-on:
* POST error condition.
* A series of beeps that indicate an error condition.
* The HMC login screen and user interface fails to start.
* A reference code or any other error information is displayed.
5. Do you have any of the failing symptoms during power on?
* No: Continue with step El
* Yes: Go to the [“Equivalent maintenance information for the HMC personal computer hardware” on|

6. Perform system unit testing using PC-Doctor. For details, see [“Performing system unit testing using]
[PC-Doctor” on page 44
7. Does the PC-Doctor diagnostics diskette start and allow tests to be run on the PC system unit?

+ No: Go to[“Testing for a power problem” on page 43|
* Yes: Go to[“Step 2. HMC problem determination.”|

Step 2. HMC problem determination

1. Perform system unit testing using PC-Doctor. For details, see [“Performing system unit testing using]
[PC-Doctor” on page 44.|Select System Unit > Run All Selected.

2. Did the system unit tests detect errors?
+ No: Go to[‘Step 3. HMC problem determination.”|
* Yes: Continue with step

3. Use the PC-Doctor diagnostics and the maintenance procedures for the type of PC that you are
working on to isolate the failure and exchange customer replaceable units (CRUs). Refer to the
publications listed in the [“Equivalent maintenance information for the HMC personal computer|
[hardware” on page 5.

4. When the problem is repaired, or if the problem cannot be isolated, continue with [“Step 4. HMC

[problem determination” on page 43|

Step 3. HMC problem determination

Attention: This step requires HMC support assistance. Contact HMC support before continuing.

1. If you are directed to reload the HMC from the recovery DVD and then reload the backup profile and
configuration data, see [Recovering the HMC}

2. After reloading the machine code from the recovery DVD, does the HMC start correctly?
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¢ No: Contact your next level of support.
* Yes: This ends the procedure.

Step 4. HMC problem determination

Note: If you reach this step and you have not been able to isolate a failure, contact your next level of
support for assistance.

1. Reinstall all CRUs that did not fix the problem.

2. You must have performed a repair action to continue. If you have not already done so, verify the
repair. For instructions, see [“Performing system unit testing using PC-Doctor” on page 44|

3. Did the system unit tests run without errors?

+ No: To troubleshoot the error, return to [“Performing system unit testing using PC-Doctor” on page
Then return here and continue with step |4

* Yes: Continue with step EI

4. Does the HMC communicate with all connected managed systems?

+ No: Go to[“Testing the modem connection to the managed system” on page 44|

* Yes: Did you exchange the system board or the system board battery?
— No: This ends the procedure.
— Yes: Recover the HMC. For details, see [Recovering the HMC} This ends the procedure.

Testing the HMC

Use these procedures when you are directed to them from the HMC problem analysis procedure to test
the HMC. If a failure is detected, you will be instructed to fix the failing part and then verify the repair.

Testing for a power problem

To troubleshoot a power problem on the PC, refer to the service documentation for the PC on which your
HMUC is based. For PC hardware maintenance manuals to help isolate the problem to a failing part, refer
to the publications listed in [“Equivalent maintenance information for the HMC personal computer|
[hardware” on page 5.

Performing diagnostic procedures

You should have been directed here to test a specific part of the HMC. For problems in the following
areas, see [“Performing system unit testing using PC-Doctor” on page 44}

 Display

* Keyboard

* Mouse

* Floppy Drive
 DVD-RAM

* DASD (disk drive)
* Memory

* Power

* Run All Selected
* SCSI

* System Port/Modem
e 16/4 Port Serial

e Ethernet
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To access the HMC diagnostic information, follow the procedures in |[Chapter 2, “Diagnostics,” on page 5/

Performing system unit testing using PC-Doctor

This section provides information to help you use the PC-Doctor diagnostics. For information on running
PC-Doctor, go to [Chapter 2, “Diagnostics,” on page 5.

Note: Performing procedures other than those specified in the following steps might cause errors.
1. Start the PC-Doctor diagnostics.

2. From the diagnostic selection display, select either Diagnostics or Interactive Tests for a list of devices
to test:

* Devices that require manual intervention (keyboard, video, mouse, diskette, optical drive) might be
selected from the interactive tests task bar.

¢ Devices that do not require manual intervention (processor, system board, I/O ports, fixed disks,
memory) and predefined test sequences (Run Normal/Quick Test) can be selected from the
diagnostic task bar.

3. Select the task containing the device or test and follow the instructions. If you were instructed to Run
All Selected, continue with that selection.

4. If the diagnostics report a failure on the PC hardware, refer to the service documentation for the PC
on which your HMC is based. For PC hardware maintenance manuals to help isolate the problem to a
failing part, refer to the publications listed in [“Equivalent maintenance information for the HM(]
[personal computer hardware” on page 5.

5. If the diagnostics do not report a failure, the HMC PC hardware is functioning correctly. If you still
have a problem, go to [‘Beginning HMC problem determination” on page 42

Testing the modem connection to the managed system

Use this procedure to test the modem connection to the PC for the HMC.
1. Can the HMC be used to communicate through the modem?

* No: Go to step@

* Yes: This ends the procedure.
2. Is a device other than a modem attached to system port 2 on the HMC?

Note: If the HMC is a rack-mounted model, answer no to this question.

+ No: Go to[“Testing the HMC modem connection.”|
* Yes: Go to step

3. System port 2 of the HMC is reserved for external modem use only. Move the serial cable from serial
ort 2 of the HMC to another HMC system port. Connect the modem to system port 2 and go to step

Note: If the HMC is a rack-mounted model, an internal modem is installed to handle the connection
of the HMC to the telephone line. If a redundant telephone connection is required, connect an external
modem to the system port on the rear of the HMC. If needed, go to the MultiTech MultiModem"
installation guide for modem installation instructions. If you do not have access to a hardcopy version

of the MultiTech MultiModem' documentation, go to the W Web site at

http:/ /www.multitech.com/documents/families /multimodemII/manuals.asp.
Testing the HMC modem connection

Use this procedure to test the modem connection to the PC for the HMC.

1. Verify that the modem and the telephone line are functioning correctly by performing the following
steps:
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On the HMC console, open the Service Agent application.
Select Test Tools.
Initiate a Test PMR.

Monitor the call log to verify that the call is completed successfully. If the call is completed
successfully, the modem is functioning correctly.

oo op

. Is the installed modem currently functioning on the HMC?

* No: Go to stepEl

* Yes: The problem is not in the modem. This ends the procedure.

. Are the HMC configurations, relating to the modem operation, correct?

* No: Correct the HMC configuration arguments. Return to step
* Yes: Continue with step El

. Is the modem powered on? (Are any indicators lit?)

* No: Ensure the modem is powered on. For details, see After power on verification is
completed, continue with step

* Yes: Go to step El
. Is the serial cable between the serial (COM) port connector of the HMC and the modem attached?
* No: Attach the serial cable between the serial (COM) port connector of the HMC and the modem.
* Yes: Load the PC-Doctor diagnostics.
— If you are working on a desktop model HMC, load the PC-Doctor from diskette or CD.

- If you are working on a rack-mounted model HMC, load the PC-Doctor from diskette using an
external USB diskette drive, CD or selecting F12 during a system shut down and restart.

Note: If you are using a CD or diskette to load PC-Doctor, shut down and restart the HMC and
wait until the PC-Doctor main menu is displayed.

. Click Diagnostics » Other Devices » Modem to perform the modem diagnostic test.
. Did the diagnostic pass?

* No: Go to step

* Yes: Go to EI

. Is the modem connected correctly to a working telephone line (or equivalent)?

Note: This can be checked by connecting a known good telephone to the line in place of the modem
and making a telephone call.

* No: Correctly connect the telephone line (or equivalent) to the modem. Go to step
After completing the telephone line and modem verification test, continue with step [9

* Yes: Go to step El

. Verify the COM port by performing the following steps:

a. Disconnect the modem cable from the COM port of the HMC.

b. Select Diagnostics from the top menu.

c. Select System Ports from the pull-down menu. The SERIAL PORT TEST CATEGORY screen
displays.

d. Ensure the following:

* On desktop HMC models - IRQ numbers 4 and 3 are assigned to COM 1 and COM 2, and the
planar to COM 2 connector cable is present and correctly installed.

* On rack-mounted models - IRQ number 4 is assigned from COM 1.
Note: If the preceding information is not correct, the COM port might be disabled, or might be

incorrectly configured. This can be resolved by accessing the setup utility (by pressing the F1
key) during power on.
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e. Ensure all diagnostics except External Loopback are selected.
f. Select Run Screen from the bottom menu.
g. Ensure all selected diagnostics show Passed.

Note: If any diagnostics fail, replace the planar.

10. Verify the external modem by performing the following steps:

11.

a. Reconnect the modem cable to the correct COM port.

b. Ensure that the modem is powered on, connected to a working telephone line, and is securely
cabled to the communications cable.

c. Press Esc to return to the PC-Doctor main menu or shut down and restart the HMC.
d. Select Hardware Info from the top menu.

e. Select COM and LPT Ports from the menu. The hardware query displays COM and LPT port
information.

f. Verify the following:
* A modem was detected on the correct COM port
* The modem test returned Passed
* Dial tone: Detected
* ATII: Displays the modem’s model information

Note:

a. If you were not able to get the desired results in step refer to the MultiTech MultiModem"
user’s guide, installation guide, or reference guide for your modem. To access the MultiTech
MultiModem" documentation, go to the w.s Web site at http:/ /www.multitech.com/
documents/families/multimodemIl/manuals.asp.

b. If necessary, after you have completed the MultiTech MultiModem" documentation, return here
to complete the final step of this procedure.

Choose from the following options:

* If the modem was not detected, replace and verify the following customer replaceable parts in the
order listed:

a. Communications cable
b. Modem
¢ If the modem test did not return with Passed, replace the modem.

* If the dial tone did not return with Detected, verify the telephone line operation then retest. If the
failure reoccurs, replace the modem.

Testing the HMC Ethernet adapter

Use this procedure to test the Ethernet adapter in the HMC.

1.

Is the Ethernet port currently functioning though normal operation of the HMC?

* No: Go to stepIZl

* Yes: This ends the procedure.

Are the Ethernet configuration values set correctly? (IP address, subnet mask, and so on.)

* No: Set the Ethernet configuration values to their correct settings. Then go back to step
* Yes: Go to step

Can the IP address of the HMC be ‘pinged’ by another system that should be able to see” the HMC
on the network?

* No: Go to step

* Yes: Go to step
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4. Is the Ethernet cable attached correctly to the HMC and the network?
* No: Attach the HMC to the network using an Ethernet cable with the correct pinout. Then go to

step
* Yes: Go to step El

5. Is the Ethernet cable the correct pinout? (There are two types of Ethernet cables in use, which are
distinguished by different pinouts. The network will determine which version of cable to use.)

* No: Replace the Ethernet cable with the correct version. Then go to step
* Yes: Go to step El
6. Perform the following steps:

a. Install the PC-Doctor diskette into drive A of the HMC: (floppy drive).

b. Shut down and restart the HMC and wait until the PC-Doctor main menu is displayed.

c. To run the Ethernet diagnostics, select Diagnostics » Other Devices » Intel Ethernet.
Did the diagnostic pass?
* No: Go to step Iz
* Yes: Go to step EI

7. Refer to the Ethernet hardware’s hardware maintenance manual to determine if there are any internal
settings or jumpers that might disable the Ethernet port.

Are there any internal settings or jumpers?
* No: Go to step
* Yes: Go to step El

8. Replace the Ethernet hardware in the HMC. (This might be a PCI card or system board replacement,
depending on the HMC hardware.) Go to step

9. Set the internal settings/jumpers to enable the Ethernet port on the HMC. Go to step
The failure does not seem to be in the HMC.

Testing the HMC disk drive

Use this procedure to test the disk drive in the HMC.
1. Did the disk drive test fail?

* No: Go to step

* Yes: Continue with the next step.
2. Perform the following steps:

a. Exchange the CRUs called by the diagnostics one at a time. For CRU removal and replacement
instructions, refer to the PC hardware maintenance manual for the system on which you are
working. See [“Equivalent maintenance information for the HMC personal computer hardware” on|
[page 5|to access the hardware maintenance manual for your HMC personal computer model.

b. After each CRU is exchanged, test the repair using the information in [“Performing system unit]
testing using PC-Doctor” on page 44|Select Hard Disk Drive problem area.

Did the disk drive test fail?
¢ No: Continue with the next step.

* Yes: Contact your next level of support.
3. Ensure the following and then continue with the next step:

 If you exchanged the disk drive and there are jumpers or tab settings on the new disk drive, ensure
that the settings are the same as the old drive.

* If there is a SCSI cable-terminating resistor device, ensure it is secured to the cable and (if
necessary) reattached to its original location on the PC.
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4.
5.

Go to "Hard Disk Jumper Settings” in the PC hardware maintenance manual. See |”Equivalenﬂ
[maintenance information for the HMC personal computer hardware” on page 5|to access the
hardware maintenance manual for your HMC personal computer model.

If you exchanged the disk drive, restore the HMC image to the new disk drive.

Use the information in [“Performing system unit testing using PC-Doctor” on page 44| to test the PC.
Select Run All Selected problem area.

e If the tests fail, isolate the problem using the [“Beginning HMC problem determination” on page 42|
procedure.

e If the tests run without errors, turn off the PC power and then turn on the power. Ensure that the
system boots and the HMC screen is displayed. This ends the procedure.

Testing the HMC DVD-RAM Drive

Use this procedure to test the DVD drive in the PC for the HMC.

1.
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Determine the media in the DVD-RAM drive:
* Compact Disk Recordable (CD-R) similar to a CD
¢ DVD-RAM media cartridge
Is the media a CD-R?
* No: Go to step El
* Yes: Continue with the next step.
Perform the following steps:
a. Clean the compact disk as follows:
* Hold the disk by its edges. Do not touch the surface.

* Remove dust and fingerprints from the surface by wiping from the center to the outside using
a dry, soft cloth.

b. Reinstall the CD, with the label-side facing up.

c. Continue with the next step.

Retry the failing task using the original media.

Does the failure occur again?

* No: Continue with the next step.

* Yes: Go to step El

This ends the procedure.

Ensure the write protect tab is in the "disabled” (down) position.

Was the write protect tab in the "disabled” (down) position?

* No: Go to step El

* Yes: Continue with the next step.

Perform the following steps:

a. With the original media in the drive, note the following:
* If you are attempting a restore procedure, turn off the PC power.
* For any other operation, shut down the HMC, and then turn off the PC power.

Note: For shutdown procedures, see [HMC and system power on and power off procedures|

b. Turn on the PC power and test the DVD-RAM drive using the information in
[system unit testing using PC-Doctor” on page 44

C. Select DVD-RAM Drive problem area.

d. When the test is complete, return here and continue with the next step.
Did the DVD-RAM test fail while testing with the original media?

* No: Go to step
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* Yes: Continue with the next step.

7. Exchange the original media with a new one.

Note: If you are replacing DVD-RAM media, the new cartridge must be formatted. If possible, use
another HMC to format the new cartridge.

8. Turn off the PC power.

9. Turn on the PC power, and test the DVD-RAM drive with the new media. Use the information in
[“Performing system unit testing using PC-Doctor” on page 44| to test the PC. Select DVD-RAM
Drive problem area.

10. Did the DVD-RAM test fail while testing with the new media?

* No: The original media was defective. This ends the procedure.

* Yes: Continue with the next step.
11. Verify the following:
* All DVD-RAM drive data and power cables are secure.
¢ The DVD-RAM drive is jumpered as "master” and is cabled to the secondary IDE bus.

12. If the diagnostics continue to fail, exchange the DVD-RAM drive. When complete, run the
DVD-RAM test again.

Note: If there are any jumpers or tab settings on the new drive, ensure that the settings match the
old drive.

13. Did the DVD-RAM Drive test continue to fail?
* No: The original DVD-RAM drive was defective. This ends the procedure.
* Yes: Continue with the next step.
14. Continue exchanging CRU from the CRU list and running the DVD-RAM drive tests.
* If the CRUs fix the problem, this ends the procedure.
* If you cannot isolate the problem, call your next level of support for assistance.

15. The PC resources (for example: interrupt, I/O address) might be configured incorrectly. Verify the PC
resources are correctly configured.

a. Select System Unit for the configuration area, and verify configuration for the system unit and
all adapters.

b. When you complete the verification, retry the failing procedure and continue with the next step.
16. Does the failing procedure continue to fail?
* No: The resource settings were incorrect. This ends the procedure.

* Yes: If you cannot isolate the problem, contact your next level of support for assistance. This ends
the procedure.

Testing the HMC diskette drive

Use this procedure to test the diskette drive in the PC for the HMC.
1. Perform the following steps:

a. Turn on the PC power and test the diskette drive using the information in [“Performing system|
[unit testing using PC-Doctor” on page 44

b. Select System Unit problem area and the test of Diskette Drive.

Note: Do not test with the diskette on which the errors occurred. Use a new diskette.
c. When the test is complete, continue with the next step.
2. Did the diskette test fail while testing with a new diskette?
* No: Go to step
* Yes: Continue with the next step.
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3. Exchange the diskette drive and run the diskette test again.

4. Did the diskette test fail again?
* No: The original diskette drive was failing. This ends the procedure.
* Yes: Continue with the next step.

5. Continue exchanging CRUs from the CRU list and running tests. If one of the replaced CRUs fixes
the problem, this ends the procedure. If you cannot resolve the problem, contact your next level of
support for assistance.

6. Did the original failure occur while writing to a diskette?
* No: Go to step
* Yes: Continue with the next step.
7. Retry the original task using a new diskette.
* If the failure occurs again, go to step
* If no failures occur, the original diskette was failing. This ends the procedure.
8. Re-create the information on the diskette, or obtain a new diskette with the information.
9. Retry the original task.
* If the failure occurs again, continue with the next step.

* If no failures occur, the original diskette was failing. This ends the procedure.

10. Test the diskette drive, using the information in [“Performing system unit testing using PC-Doctor”]
Select System Unit problem area and the test of Diskette Drive.

* If the tests fail, isolate the problem using the procedures found in the PC hardware maintenance
manual. For additional PC maintenance information, see [“Equivalent maintenance information for|
[the HMC personal computer hardware” on page 5|to access the hardware maintenance manual for
your HMC personal computer model.

* If the tests do not isolate the problem, contact your next level of support for assistance.
Testing the HMC display

Use this procedure when you are having a display problem with the HMC.
1. Is the display type a 95xx (17P, 17X, 21P)?

¢ No: Continue with the next step.

* Yes: 95xx-xxx repairs might require replacing internal display CRUs.

Repair and test the display using the procedures in Monitor Hardware Maintenance Manual Vol 2,
S41G-3317.

2. Is the display type a 65xx (P70, P200)?
* No: Continue with the next step.

* Yes: 65xx-xxx repairs might require replacing the entire display. There are no internal display CRUs.
Repair and test the display using the procedures in Monitor Hardware Maintenance Manual Vol 3, P
and G series, S52H-3679.

When the test and repair are complete, continue with step
3. Is the display type a 65xx (P72, P202)?
¢ No: Continue with the next step.

* Yes: 65xx-xxx repairs might require replacing the entire display. There are no internal display CRUs.
Repair and test the display using the procedures in Color Monitor Operating Instructions.

When the test and repair are complete, continue with step
4. Repair and test the display using the documentation included with the display. When the test and
repair are complete, continue with step

5. Verify the repair using the information in [“Performing system unit testing using PC-Doctor” on page|
Select System Unit for the problem area and the Test for Display.

50 HMC models 7042-CR4, 7042-C06, and 7042-C07 service



When the test and repair are complete, continue to step EI
6. Return the system to normal operations. This ends the procedure.

Replacing an HMC

Learn about the tasks you must perform when replacing an HMC.

If you are replacing an HMC that is set up as a DHCP server, you must first reinstall the HMC code base
by using one of the following:

* The recovery media that was provided with your HMC
* The recovery media that you last used to upgrade your HMC

You must also reinstall your customized HMC configuration data by using backup media.
Procedures for replacing an HMC differ, depending on which HMC version you have installed. To

determine your HMC version, see [Determining your HMC machine code version and release| and then
return here.

These instructions assume that you have created a backup of your HMC configuration data from the
HMC being replaced. For more information about backing up important HMC data, see
fcritical HMC datal

For HMC V4.5 or earlier

1. Insert the HMC recovery media, then power on or reboot the HMC. The HMC powers on and
loads from the media.

2. Press F8 to select Install/Recovery.

3. Press F1 to continue. After the installation is complete, the HMC prompts you to insert the
backup media.

4. Insert the backup media. When you are finished, the HMC is restored to the state that it was
in at the time that the backup was created.
5. After the HMC interface has been restored, verify that your HMC DHCP private network is
configured correctly. For more information, see [Verifying that your HMC DHCP private|
[network is configured correctly]
For HMC V5.0 or later

1. Insert the HMC recovery media, then power on or reboot the HMC. The HMC powers on
from the media and displays the Backup/Upgrade/Restore/Install panel.

2. Select Install and click Next. Wait for the installation to complete.

3. Select 1 - Install additional software from media from the menu displayed to install the
second HMC recovery media.

4. Remove the recovery media and insert the second media.
5. Press Enter to start the installation of the second recovery media.

6. After the installation is complete, remove the second recovery media, insert the backup media,
and select 1 - Restore Critical Console Data from the menu to restore data from the backup
media. When you are finished, the HMC is restored to the state that it was in at the time that
the backup was created.

7. After the HMC interface has been restored, verify that your HMC DHCP private network is
configured correctly. For more information, see [Verifying that your HMC DHCP private]
[network is configured correctly]
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Verifying that your HMC DHCP private network is configured correctly

This section applies to all DHCP-managed managed systems. Read this article to learn how to verify that
your HMC DHCP private network is configured correctly.

If your HMC is configured as a DHCP server on a private network and is not communicating correctly
with the managed system, or you have recently modified your network configuration (moved a managed
system, replaced an HMC, or added a second HMC), use the following instructions to determine if your
DHCP-managed private network is configured correctly.

Note: If your HMC is set up as a DHCP server on a private network, do not use the static IP commands
mksysconn and rmsysconn to change HMC connection settings. These commands are intended for use on
a public network only, where the HMC is not set up as DHCP server and managed servers use static IP
addresses.

If a system administrator previously assigned an IP address to the system through a manually executed
static IP command, Support must remove the manual connection and establish a DHCP connection
between the HMC and the server. This section describes how to identify any manually assigned IP
addresses so that an authorized service provider can remove them.

To identify a manually assigned IP address so that your HMC can communicate correctly with your
managed systems, you must perform the following high-level tasks. The following are detailed
step-by-step task descriptions.

* Identify the configured HMC IP connection addresses and compare them to the list of IP addresses
assigned by the DHCP server.

* Identify the HMC IP connection addresses that have been correctly assigned through the DHCP server,
for which no further action is required.

* Identify any manually configured HMC IP connection addresses that DHCP did not assign and that
need to be corrected by support.

To identify manually assigned IP addresses when the HMC is configured as a DHCP server, do the
following

1. Create a list of all of the configured HMC IP connections. On the HMC command line, type the
following command:

Issysconn -r all

This command displays the following information for service processors and Bulk Power Cards
(BPCs) on the network for which the HMC has configured IP connection:

element type, MTMS, IP address(es), connection state
2. Make a note of all IP addresses that are displayed. You will need these addresses later.

3. Display a list of the DHCP IP addresses that have been assigned. To do this, type the following HMC
command:

Ishmc -n -F clients

The output of this command lists all IP addresses that have been assigned by the HMC’s DHCP
server.
4. Make a note of all IP addresses that are listed in the output.

5. Compare the Issysconn and Ishmc lists. If an IP address is displayed in the output for both the Ishmc
-n -F clients and Issysconn -r all commands, the IP address was assigned by the HMC DHCP server
and the connection is being managed by the HMC DHCP server.

6. Remove from the list any address that is displayed in the output of the Ishmc -n -F clients command
but not displayed in the output of the Issysconn -r all command, and is not in the list of servers that
use static IP addresses.
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Note: If an IP address is displayed in the Ishmc -n output and not in the Issysconn -r all output, that
IP address was assigned by the HMC DHCP server. However, it is not a current connection on the
HMC. The DHCP server keeps a history of all IP address assignments in the event that the connection
is re-established. The DHCP server might also have assigned an IP address if an unknown device on
the private network requested a DHCP IP address from the HMC.

7. If the HMC is managing servers on both a private and a public network, any connections to the
service processor on the public network (not in the private network address range) must also be
identified and removed from this list. If there are no IP adresses remaining in the list that contains the
Issyconn -r all output, the HMC DHCP server has assigned all of the system IP addresses, and the
network configuration is working correctly.

8. If there are any IP addresses not removed from the list taken from the Issysconn -r all command, this
address was not assigned by the HMC’s DHCP server. These IP address assignments must be
corrected, so that they can be automatically reassigned by the HMC DHCP server. Contact an
authorized service provider and request that someone correct the manually assigned IP addresses that
you have identified.

If you have followed this procedure and not all of your connections appear to be active, call an
authorized service provider for additional support.

Backing up critical HMC data

You can back up important console information to DVD, a remote system mounted to the HMC file
system (such as NFS), or a remote site through FTP.

Using the HMC, you can back up all important data, such as the following:
* User-preference files

* User information

* HMC platform-configuration files

* HMC log files

* HMC updates through Install Corrective Service

The Backup function saves the HMC data stored on the HMC hard disk to DVD, a remote system
mounted to the HMC file system (such as NFS), or a remote site through FTP. Back up the HMC after
you have made changes to the HMC or to the information associated with logical partitions.

Note: Before data can be saved to the DVD, the DVD must be formatted in the DVD-RAM format.

To back up the HMC, you must be a member of one of the following roles:
* super administrator
* operator

* service representative

To back up the HMC critical data, do the following:
1. In the Navigation area, click HMC Management.
2. Select Back up HMC Data.

3. Select an archive option. You can back up to DVD on the local system, back up to a mounted remote
system, or send backup data to a remote site.

4. Follow the instructions on the window to back up the data.

Determining your HMC machine code version and release

Determine how to view the HMC machine code version and release.
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The level of machine code on the HMC will determine the available features, including concurrent server
firmware maintenance and enhancements to upgrading to a new release.

1. In the Navigation area, click Updates.

2. In the Work area, view and record the information that is displayed under the HMC Code Level
heading, including: the HMC version, release, maintenance level, build level, and base versions.

3. To update your HMC machine code version and release, see Obtaining HMC machine code updates
and upgrades. This ends the procedure.

Preparing for HMC configuration

Use this section to gather required configuration settings that you need to know before you begin the
configuration steps.

To configure the HMC, you must understand the related concepts, make decisions, and prepare
information.

This section describes the information you will need to connect your HMC to the following:
* Service processors in your managed systems

* Logical partitions on those managed systems

* Workstations used by HMC administrators

* IBM Service, to implement “call-home” functions

To prepare for HMC configuration, do the following:

1. Determine if this is a new HMC supporting one or more new systems, or if this is a second new
HMC supporting existing systems. This will determine which installation path to follow.

2. Determine the physical location of the HMC in relation to the servers it will manage. If the HMC is
more than 25 feet from its managed system, you must provide Web browser access to the HMC from
the managed system’s location so that service personnel can access the HMC.

3. Identify the servers that the HMC will manage.

4. Determine whether you will use a private or an open network to manage servers. The HMC
manages the servers through the Flexible Service Processor (FSP) over a network connection. A
private network is a non-routable network from the HMC to one or more FSPs. An open network is
any routable network linking the HMC to FSPs, logical partitions, administrative workstations or
other network devices, such as routers and firewalls. A private network is recommended for HMC
management of all systems. Servers that have bulk power controllers require a private network with
an HMC acting as a Dynamic Host Control Protocol server (DHCP). Review the available
non-routable network subnet ranges that are available and determine which one you will use for
each DHCP server. Each FSP may be connected to two HMCs acting as DHCP servers as long as
they are using two different IP address ranges.

5. If you will use an open network to manage an FSP, you must set the FSP’s address manually
through the Advanced System Management Interface (ASMI) menus. A private, non-routable
network is recommended.

6. Determine the open network settings that you will need to connect the HMC to workstations used
by system administrators, logical partitions on the managed systems, and other network devices.
Also, determine how the HMC will “call home.” Call home options can include an outbound-only
Secure Sockets Layer (SSL) Internet connection, a modem, or a Virtual Private Network (VPN)
connection.

7. Determine the HMC users that you will create and their passwords, as well as which roles they will
be given.

8. Document the following company contact information that will be needed when configuring call
home:

¢ Company name
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* Administrator contact

* e-mail address

* Telephone numbers

¢ Fax numbers

* The street address of the HMC physical location

9. If you plan to use e-mail to notify operators or systems administrators when information is sent to
IBM Service through call-home, identify the Simple Mail Transfer Protocol (SMTP) server and the
e-mail addresses you will use.

10. If this is a new HMC connecting to a new managed system, create a password that will be used to
authenticate the HMC to the FSP. At the same time, create a password for the Advanced System
Management Interface (ASMI) admin and general users. All three passwords can be set when
connecting the first time from the HMC to a new server. If the HMC is a redundant or dual HMC,
obtain the HMC User password and be prepared to enter it when connecting the first time to the
managed server’s FSP.

Shutting down, logging off, and disconnecting the HMC

Learn how to shut down, log off, and disconnect the HMC interface.
Shut down, log off, and disconnect the HMC interface.

Attention: Only use the white button on the HMC to perform a manual shutdown if the server does not
respond to any tasks performed from the console, such as shutting down the HMC.

If an operating system is open and running on a partition, and you decide to shut down, reboot, or log
off the HMC interface, the operating system continues to run without interruption.

Logging off the HMC

Perform the following steps:
1. In the main menu, click Logoff. The Choose to Logoff or Disconnect window opens.
2. Click Log off, then click OK.

Disconnecting from the HMC interface

To disconnect from the HMC interface, do the following;:
1. In the main menu, click Logoff. The Choose to Logoff or Disconnect window opens.
2. Click Disconnect, then click OK.
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.

The manufacturer may not offer the products, services, or features discussed in this document in other
countries. Consult the manufacturer’s representative for information on the products and services
currently available in your area. Any reference to the manufacturer’s product, program, or service is not
intended to state or imply that only that product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any intellectual property right of the
manufacturer may be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any product, program, or service.

The manufacturer may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these patents. You can
send license inquiries, in writing, to the manufacturer.

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: THIS INFORMATION IS PROVIDED “AS IS” WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
The manufacturer may make improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to Web sites not owned by the manufacturer are provided for
convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at
those Web sites are not part of the materials for this product and use of those Web sites is at your own
risk.

The manufacturer may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning products not produced by this manufacturer was obtained from the suppliers of
those products, their published announcements or other publicly available sources. This manufacturer has
not tested those products and cannot confirm the accuracy of performance, compatibility or any other
claims related to products not produced by this manufacturer. Questions on the capabilities of products
not produced by this manufacturer should be addressed to the suppliers of those products.

All statements regarding the manufacturer’s future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only.
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The manufacturer’s prices shown are the manufacturer’s suggested retail prices, are current and are
subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

If you are viewing this information in softcopy, the photographs and color illustrations may not appear.

The drawings and specifications contained herein shall not be reproduced in whole or in part without the
written permission of the manufacturer.

The manufacturer has prepared this information for use with the specific machines indicated. The
manufacturer makes no representations that it is suitable for any other purpose.

The manufacturer’s computer systems contain mechanisms designed to reduce the possibility of
undetected data corruption or loss. This risk, however, cannot be eliminated. Users who experience
unplanned outages, system failures, power fluctuations or outages, or component failures must verify the
accuracy of operations performed and data saved or transmitted by the system at or near the time of the
outage or failure. In addition, users must establish procedures to ensure that there is independent data
verification before relying on such data in sensitive or critical operations. Users should periodically check
the manufacturer’s support websites for updated information and fixes applicable to the system and
related software.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked
terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these
symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at "Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.

Electronic emission notices

Class A Notices
The following Class A statements apply to the IBM servers that contain the POWER6 processor.

Federal Communications Commission (FCC) statement

Note: This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications. Operation of this
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equipment in a residential area is likely to cause harmful interference, in which case the user will be
required to correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC emission
limits. IBM is not responsible for any radio or television interference caused by using other than
recommended cables and connectors or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Industry Canada Compliance Statement

This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité a la réglementation d’Industrie Canada

Cet appareil numérique de la classe A respecte est conforme a la norme NMB-003 du Canada.
European Community Compliance Statement

This product is in conformity with the protection requirements of EU Council Directive 2004/108/EC on
the approximation of the laws of the Member States relating to electromagnetic compatibility. IBM cannot
accept responsibility for any failure to satisfy the protection requirements resulting from a
non-recommended modification of the product, including the fitting of non-IBM option cards.

This product has been tested and found to comply with the limits for Class A Information Technology
Equipment according to European Standard EN 55022. The limits for Class A equipment were derived for
commercial and industrial environments to provide reasonable protection against interference with
licensed communication equipment.

European Community contact:

IBM Technical Regulations

Pascalstr. 100, Stuttgart, Germany 70569
Tele: 0049 (0)711 785 1176

Fax: 0049 (0)711 785 1283

E-mail: tjahn@de.ibm.com

Warning: This is a Class A product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

VCCI Statement - Japan

CHEEIL. FHRUEBLESZEHIEZTHEEAFBES (VCC 1) OESE
ICEDCIVTAARBHREMEBTY, COEBERERETCHERATIEER
BEASZRBITEFHYET, COBAICEFERHEN B LN ELET
B3LHIBRENBIEDHIET,

The following is a summary of the VCCI Japanese statement in the box above.
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This product is a Class A Information Technology Equipment and conforms to the standards set by the
Voluntary Control Council for Interference by Information Technology Equipment (VCCI). In a domestic
environment, this product may cause radio interference, in which case the user may be required to take
adequate measures.

Electromagnetic Interference (EMI) Statement - People’s Republic of China

B 5
HWh A K=& EEFETIRF.
ST S EA TR TR
EXHFHEOAT - TERBEAP R
TR ET{THIE K.

Declaration: This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may need to perform practical action.

Electromagnetic Interference (EMI) Statement - Taiwan

CEBERE
FRFHOANER 4
BRI T AT T
EREAMATE £
HHAT > EAHHRE
RERELBEQHE -

The following is a summary of the EMI Taiwan statement above.

Warning: This is a Class A product. In a domestic environment this product may cause radio interference
in which case the user will be required to take adequate measures.

14 B 7 7 5t 5 1754,

15 8 B X 2 S 2 I TR
A i - B 793

Faryg - 0800-016-888

60 HMC models 7042-CR4, 7042-C06, and 7042-C07 service



Electromagnetic Interference (EMI) Statement - Korea

of 7|71 4R goz AARATSZS o JJlol2l BHA
E AEAE o|FS FofstA7| Hieim, woF FE @ =
Fhstg S wWols Jtg 82 BEsHAZ] vlFUTE.

Please note that this equipment has obtained EMC registration for commercial use. In the event that it
has been mistakenly sold or purchased, please exchange it for equipment certified for home use.

Germany Compliance Statement

Deutschsprachiger EU Hinweis: Hinweis fiir Gerdte der Klasse A EU-Richtlinie zur
Elektromagnetischen Vertraglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2004/108/EG zur Angleichung der

Rechtsvorschriften iiber die elektromagnetische Vertrdglichkeit in den EU-Mitgliedsstaaten und hélt die
Grenzwerte der EN 55022 Klasse A ein.

Um dieses sicherzustellen, sind die Gerdte wie in den Handbiichern beschrieben zu installieren und zu
betreiben. Des Weiteren diirfen auch nur von der IBM empfohlene Kabel angeschlossen werden. IBM
iibernimmt keine Verantwortung fiir die Einhaltung der Schutzanforderungen, wenn das Produkt ohne
Zustimmung der IBM verdndert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung der IBM gesteckt/eingebaut werden.

EN 55022 Klasse A Gerédte miissen mit folgendem Warnhinweis versehen werden:

"Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im Wohnbereich
Funk-Stoérungen verursachen; in diesem Fall kann vom Betreiber verlangt werden, angemessene
Mafinahmen zu ergreifen und dafiir aufzukommen.”

Deutschland: Einhaltung des Gesetzes iiber die elektromagnetische Vertraglichkeit von Geriten

Dieses Produkt entspricht dem “Gesetz iiber die elektromagnetische Vertraglichkeit von Gerdten
(EMVG)”“. Dies ist die Umsetzung der EU-Richtlinie 2004/108/EG in der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz iiber die elektromagnetische Vertriaglichkeit von

Gerdten (EMVG) (bzw. der EMC EG Richtlinie 2004/108/EG) fiir Gerite der Klasse A.

Dieses Gerit ist berechtigt, in Ubereinstimmung mit dem Deutschen EMVG das EG-Konformititszeichen

- CE - zu fihren.

Verantwortlich fiir die Konformitétserklarung nach des EMVG ist die IBM Deutschland GmbH, 70548
Stuttgart.

Generelle Informationen:

Das Gerit erfiillt die Schutzanforderungen nach EN 55024 und EN 55022 Klasse A.

Appendix. Notices

61



Electromagnetic Interference (EMI) Statement - Russia

BHUUMAHWE! HacTtosiwee nagenue oTHocUTCS K Kraccy A.
B XMnbIX NOMELLLEHUSIX OHO MOXeT co3faBaTtb
pagnonoMexu, AN CHUKEHUS KOTOPbIX HEODXOANMBI
OOMNOMHUTENbHbIE MEpPbI

Terms and conditions

Permissions for the use of these publications is granted subject to the following terms and conditions.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of the manufacturer.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of the manufacturer.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any data, software or other intellectual property contained
therein.

The manufacturer reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as determined by the manufacturer,
the above instructions are not being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

THE MANUFACTURER MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THESE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED
WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR
PURPOSE.
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